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1 What's New

New features in ODBC Driver for SAP Sybase Adaptive
Server Enterprise 4.0

e Added a graphical interface for configuring the driver on macOS and Linux

e Added support for the Bearer Token authentication when using an HTTP tunnel
¢ Improved compatibility with Node.js

e Improved compatibility with Tableau

e Improved compatibility with Vectorworks

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 3.6
¢ Added support for password-protected private keys for the SSL protocol

¢ Improved compatibility with Microsoft Query

New features in ODBC Driver for SAP Sybase Adaptive
Server Enterprise 3.5

¢ Added the option for showing metadata only for the current catalog

New features in ODBC Driver for SAP Sybase Adaptive
Server Enterprise 3.4

¢ Fixed connection timeout setting before opening connection
¢ Improved compatibility with FileMaker Server for Ubuntu
¢ Improved compatibility with FileMaker Server for MacOS

¢ Now passwords are stored in an encrypted form in the DSN record

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 3.3
e Added support for SQL_ATTR_MAX_ ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio
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e Added support for macOS 13 Ventura

Improved compatibility with the OTL library

Improved compatibility with Tableau Prep Builder

Improved compatibility with Crystal Reports

Improved the SSH connection establishment

Reduced number of metadata calls

Improved compatibility with 4D in macOS

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 3.2
e Added support for Windows 11

Improved compatibility with FICO Mosel

Improved compatibility with FileMaker

Improved compatibility with Linked Server in MSSMS

Improved compatibility with JMP on macOS

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 3.1
e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 3.0
e Apple Silicon M1 is supported

e Compatibility with macOS Big Sur is improved

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 2.1
e Now ODBC driver is thread-safe

¢ Now ODBC driver activation does not require administrator privileges
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e Work with password-protected private key for SSH protocol is supported
¢ Improved compatibility with sandboxed applications for macOS
e The Multiple Connections connection option is added

e Support for connection pooling is improved

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 2.0
e Now ODBC driver for macOS is distributed as a PKG package

e Now ODBC driver for Linux is distributed as DEB and RPM packages
¢ Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for SAP Sybase Adaptive
Server Enterprise 1.4

e Possibility to return String Types as Ansi or Unicode is added
e Compatibility with MS Access is improved

e Compatibility with Tableau is improved

e Compatibility with Omnis Studio is improved

e Compatibility with Power Pivot is improved

e Compatibility with DBeaver is improved

New features in ODBC Driver for SAP Sybase Adaptive
Server Enterprise 1.3

¢ Performance of batch operations is significantly improved

e The SSHStoragePath connection parameter is added

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 1.2
e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved
e OUTER JOIN macros in SQL queries are supported
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e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 1.1
e Support for IPv6 protocol is added

e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved

e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved

e Compatibility with Qlik is improved

e Compatibility with Delphi & C++Builder is improved

e MS Access linked tables support is improved

New features in ODBC Driver for SAP Sybase Adaptive

Server Enterprise 1.0
e First release of ODBC Driver for SAP Sybase Adaptive Server Enterprise

e Windows is supported
e Linuxis supported

e macOS is supported

2 General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support
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2.1

Overview

Overview

Devart ODBC Driver for SAP Sybase ASE is a high-performance connectivity solution with
enterprise-level features for accessing ASE databases from ODBC-compliant Bl, reporting,
analytics, and ETL tools on both 32-bit and 64-bit Windows, macOS, and Linux. Our ODBC
driver fully supports standard ODBC API functions and data types and enables easy and
secure access to live SAP Sybase ASE data from anywhere.

v ODBC API
ODBC Data -
Types

Direct connection

Our connectivity solution enables various ODBC-aware applications to establish a direct
connection to SAP Sybase Adaptive Server Enterprise via TCP/IP to eliminate the need for

ASE client. A direct connection increases the speed of data transmission between an external

application and ASE server for real-time analytics. It also streamlines the deployment
process, since there is no need to distribute any additional client software with the driver.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

6 ODBC Driver for ASE

Application

ODBC Interface BJ’

TCP/IP
Driver Manager

ASE
Devart ODBC driver
for ASE

Compatibility

ODBC Diriver for SAP Sybase Adaptive Server Enterprise supports the following versions of
Adaptive Server Enterprise:

e SAP Adaptive Server Enterprise 16.0 and higher
e Sybase Adaptive Server Enterprise 12.5.4 and higher

2.2 Features

Application
ODBC Interface BJ'
TCP/IP
Driver Manager
ASE
Devart ODBC driver
for ASE

Direct Connection

Database applications based on our solution get an opportunity to establish connection to
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ASE directly via TCP/IP. That improves performance of your applications, their quality,
reliability and especially the deployment process, since there is no need to supply additional
client software together with your application.

v ODBC API
ODBC Data -
Types

ODBC Conformance

Our ODBC driver provides full support for common ODBC interface:
e ODBC Data Types support

e ODBC API Functions support

In addition, we provide support for Advanced Connection String parameters. Thus allowing
any desktop and web applications to connect to ASE from various environments and
platforms, that support ODBC.

64

bit

32

bit

Development Platforms Variety

ODBC Driver for SAP Sybase Adaptive Server Enterprise doesn't limit your choice of the
development platform and environment. The driver installations are available for various
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8 ODBC Driver for ASE

operational systems and platforms. The current version supports Windows, macOS, Linux,
both 32-bit and 64-bit. So you can develop both 32-bit and 64-bit cross-platform applications.

]
] I

—

Database Compatibility

ODBC Driver for SAP Sybase Adaptive Server Enterprise supports the following versions of
Adaptive Server Enterprise:

e SAP Adaptive Server Enterprise 16.0 and higher
e Sybase Adaptive Server Enterprise 12.0 and higher

=2l

High Performance

All our products are designed to help you write high-performance, lightweight data access

layers, therefore they use advanced data access algorithms and techniques of optimization.
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| v

Support

Visit our Support page to get instant help from knowledgeable and experienced professionals,
a quick resolution of your problems, and nightly builds with hotfixes.

2.3 Compatibility

ASE Compatibility

ODBC Driver for SAP Sybase Adaptive Server Enterprise supports the following database

servers:
ASE versions Support
SAP Adaptive Server Enterprise 16.0 and higher v,

Sybase Adaptive Server Enterprise 12.5.4 and higher v

Supported Platforms

e Windows x86 and x64 (including Windows Terminal Server)
e macOS x64 and ARM (Apple Silicon M1)
e Linux x86 and x64

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion v
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Embarcadero Delphi & C++Builder

UniDAC, FireDAC, dbGo (ADO), BDE and dbExpress v
FileMaker v
Lazarus v
Microsoft Visual FoxPro v
Microsoft Visual Studio _ W,

Server Explorer and ADO.NET ODBC Provider
Omnis Studio v
PHP v
PowerBASIC v
Python v

Database Management
Aqua Data Studio v
dbForge Studio v
dBeaver v
EMS SQL Management Studio v
Informatica Cloud v
RazorSQL v
SQL Server Data Tools v
SQL Server Management Studio v
SQL Server Reporting Services v

Bl & Analytics Software
Alteryx v
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DBxtra

Dundas Bl

IBM SPSS Statistics

MicroStrategy

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

CICIC SIS

TIBCO Spotffire

Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

CIC S ]K

StarOffice

24 Requirements

The following requirement must be met for ODBC Driver for SAP Sybase Adaptive Server
Enterprise:
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2.5

¢ Only one version of ODBC Driver for SAP Sybase Adaptive Server Enterprise is installed on

your system.

No additional client software is required on your system.

Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/ase/
https://www.devart.com/odbc/

General Information 13

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:

- make any number of copies of the Software to deploy it to your end-user.
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- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.
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5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fithess for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT
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The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.

26 Getting Support

This document lists several ways you can find help with using ODBC Driver for SAP Sybase
Adaptive Server Enterprise describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for SAP
Sybase Adaptive Server Enterprise:
¢ You can find out more about ODBC Driver for SAP Sybase Adaptive Server Enterprise

installation or licensing by consulting Installation and License articles of this manual

respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for SAP Sybase Adaptive
Server Enterprise developers through the ODBC Driver for SAP Sybase Adaptive Server

Enterprise Priority Support program.

Subscriptions
The ODBC Driver for SAP Sybase Adaptive Server Enterprise Subscription program is an

annual maintenance and support service for ODBC Driver for SAP Sybase Adaptive Server
Enterprise users.

Users with a valid ODBC Driver for SAP Sybase Adaptive Server Enterprise Subscription get

the following benefits:

e Product support through the ODBC Driver for SAP Sybase Adaptive Server Enterprise
Priority Support program
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e Access to new versions of ODBC Driver for SAP Sybase Adaptive Server Enterprise when
they are released

e Access to all ODBC Driver for SAP Sybase Adaptive Server Enterprise updates and bug
fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for SAP Sybase Adaptive Server Enterprise Priority Support is an advanced
product support service for getting expedited individual assistance with ODBC Driver for SAP
Sybase Adaptive Server Enterprise-related questions from the ODBC Driver for SAP Sybase
Adaptive Server Enterprise developers themselves. Priority Support is carried out over email
and has a two business day response policy. Priority Support is available for users with an
active ODBC Driver for SAP Sybase Adaptive Server Enterprise Subscription.

To get help through the ODBC Driver for SAP Sybase Adaptive Server Enterprise Priority
Support program, please send an email to support@devart.com describing the problem you

are having. Make sure to include the following information in your message:

Your ODBC Driver for SAP Sybase Adaptive Server Enterprise Registration number.

e Full ODBC Driver for SAP Sybase Adaptive Server Enterprise edition name and version
number. You can find the version number in DLL version information.

¢ Versions of the ASE server and client you are using.

¢ A detailed problem description.

e |f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for SAP Sybase Adaptive Server Enterprise.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com.

3 Using ODBC Driver

1. Installation

2. Product Activation
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. Connecting to ASE

. Connection String Parameters

. Secure Connections

3
4
5
6. Sandboxed Apps on macOS
7
8
9

. Using with iODBC
. Enabling ODBC Tracing

. Supported Data Types
10.Supported ODBC API Functions

3.1 Installation
ODBC Driver for SAP Sybase Adaptive Server Enterprise currently supports the following
platforms: Windows, macOS, and Linux, both 32-bit and 64-bit.

See how to install Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise:

e \Windows

e Windows Silent

e macOS
e Linux DEB
e Linux RPM

3.1.1 Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/ase/download.html

Using ODBC Driver 19

5 Setup - Devart ODBC Driver for ASE - X

Welcome to the Devart ODBC Driver for
ASE Setup Wizard

This will install Devart ODBC Driver for ASE 3.6.0 on your
computer.

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

YWARNING: This program is protected by copyright law and
international treaties.

ODBC Driver

for Adaptive
Server Enterprise

3. If you already have the specified installation folder on the PC or another driver version is
installed, you will get a warning. Click Yes to overwrite the old files with the current
installation, but it is recommended to completely uninstall the previous driver version first,
and then install the new one.

4. On the Select Components page, you can choose whether to install the 64-bit version of
the driver. Clear the checkbox if you do not need a 64-bit installation. There is also a

checkbox on this page that allows you to choose whether to install Help and Manual.
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EEJ Setup - Devart ODBC Driver for ASE

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue,

Full installation e
ﬂ Devart QDBC Driver for ASE 7, 7MB
- (@ Driver for Win32 3,1MB
.. [ Driver for Wing4 4,6 MB
B Help and Manual 13,3 MB

Current selection reguires at least 23,2 MB of disk space.

5. On the License Information page, select when you want to activate the driver:

¢ Immediately after installation: Select Input Purchased or Trial activation key and

enter your key in the provided box, or click Load Activation Key and select the file

containing your key.

¢ Any other time: Select Activate product later.

You need to activate the driver even for the trial version.

You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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EEJ Setup - Devart ODBC Driver —

License Information

Enter yvour Purchased or Trial Key to activate the product. Getit on the
Customer Portal or load it from a file,

@ Input Purchased or Trial activation key

() Activate product later

U 1w FCODEMNGAEOF gbMzjuck JzV xGPY rkR Y SHB 7Tv

+th4+CRDPhEPZARMSEPY pPasaPTivaYeiQ 2bi TRigY yHAI FTTkhb dKEzWogdt oxsSUZ]
bzgVyAuSz2DgX FREMAhZ]D+HhPajyghTIEy Ez 7Due0QX tspppd SR IkS0uAILTIdOW
enAJQMzQGvDgF Sy /dz09B0Inrhg S9KEgficpgwTZIWE mmmTokvCkLICxSSom3Ei9gh
BqWcbDug/SlzakxSGEAWKSECSY 15gWYT +RIQF Y gALILIOtk 18N A=

Get Purchased or Trial Activation Key... Load Activation Key ...

6. Click Next to complete the installation.
7. Click Finish to exit Setup.

8. After the installation is completed, you need to configure the driver.

See also:

¢ |nstallation on macOS

e |nstall Linux DEB package

¢ Install Linux RPM package

3.1.2 Windows Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:
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DevartODBCASE.exe /SILENT /ActivationKey=ylc7nmgdu2341aszxcvONGurjfhxm90LHuy
DevartODBCASE.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtrilwq98n
Note: The installation is performed by entering a license key.

DevartODBCASE.exe /SILENT /ActivationFile=d:\1ic.key

DevartODBCASE.exe /VERYSILENT /ActivationFile=d:\1lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is

required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

macOS

Prerequisites

ODBC Driver for SAP Sybase Adaptive Server Enterprise works under the control of an
ODBC driver manager. ODBC driver manager is not distributed along with our driver and
must be installed separately.

ODBC Driver for SAP Sybase Adaptive Server Enterprise is compatible with iODBC driver
manager.

In case when using other ODBC driver managers, ODBC Driver for SAP Sybase Adaptive
Server Enterprise will be installed, but it will require manual modification of the configuration
files of these managers.

Installing ODBC Driver for SAP Sybase Adaptive Server
Enterprise

1. Go to Security & Privacy settings in the System Preferences.
2. Enable the App Store and identified developers option in the Allows apps downloaded

from section.
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[ ] 4 G Security & Privacy Q

m FileVault = Firewall  Privacy

A login password has been set for this user Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

) App Store
° App Store and identified developers

~

Eﬁ Click the lock to prevent further changes. Advanced... ?

If the options in Allow apps downloaded from section are grayed out, click the lock icon and

enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, click Allow to proceed with the installation.
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o0 ‘& Install Devart ODBC Driver for ASE ]

Welcome to the Devart ODBC Driver for ASE Installer

This will install Devart ODBC Driver for ASE 1.5.9 on your

@ Introduction computer.
Read Me WARNING: This program is protected by copyright law and international
} treaties
License

Registration
Destination Select
Installation Type
Installation

Summary

Continue

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver =

To continue installing the software you must agree to the terms of
the software license agreement.

inY Click Agree to continue or click Disagree to cancel the installation and
Rei quit the Installer.
Lic
Rel . . ps
Read License Disagree Agree
De|
nstallation Type
INTRODUCTION
nstallation
- . This Devart end-user license agreement ("Agreement”) is a legal
summary agreement between you (either an individual person or a single legal

entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. On the Registration page, specify your activation key using one of the following methods:

e Enter an activation key:

1. Select Input Purchased or Trial activation key.

2. Enter your activation key.
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[ ] w Install Devart ODBC Driver
Registration

License information

Enter your Purchased or Trial Key to activate the product. Get
Read Me it on the Customer Portal or load it from a file. Alternatively,
use the existing key.

Introduction

License

. . Input Purchased or Trial activation ke
® Registration O Inp y
Use existing activation key or activate product later

LleGzgzn3kJ3RPGYaSNmMTIFTebsNiHX4j5h+vdOjxEE2letLKA+p/
KrdNx3m7 1vaktsotElzQUg/
Cez19+YeFRpdx5LO2+MhIQ8R2IWsDYKThoZ X OGAUKaEG4s5TIN
J1EijViQ5gZ0g1BkNgXaLytOgsAZgLIHysizWU+vAZOgvar09iGVHa
N544EI7/wAVQOIEVEQqRRsKnZenDRNIJ36gjo2ShPUGZI7DwWMS

Get Purchased or Trial Activation Key...

Load Activation Key...

Improvement Program®

*Help us improve our products and fix issues faster by sharing a limited set of
anonymous data, including functionality usage statistics, diagnostic infermation, and
performance data.

Go Back Continue

¢ Load an activation key file:
1. Click Load Activation Key.

2. Navigate to the location of the activation file.

3. Click Open.
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o0 '« Install Devart ODBC Driver
Registration

License information

Enter your Purchased or Trial Key to activate the product. Get
it on the Customer Portal or load it from a file. Alternatively,
use the existing key.

Introduction
Read Me
License

© Input Purchased or Trial activation key

® Registration
Use existing activation key or activate product later

Get Purchased or Trial Activation Key...

Load Activation Key... ¥

Improvement Program®*

27

Favorites

T Recents

H
H
H

i
<
|

v [ Downloads

A Applications Name

[ Documents B activation.key

1) Downloads

iCloud
> iCloud Drive

Locations
& BigSure
& Machintosh...

& pub &
i Network

Tags

8 a

Kind

w
I

300 bytes

Cancel

Keynote Document

You need to activate the driver even for the trial version.

You can find your activation key in the registration email or your Customer Portal account. To

open the Customer Portal, click Get Purchased or Trial Activation Key.

If you're reinstalling the driver or don't want to activate the driver right now, select Use

existing activation key or activate product later.

7. To complete the installation click Continue, then click Install.
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& & Install Devart ODBC Driver

The installation was completed successfully.

Introduction
Read Me
License
Registration

Destination Select The installation was successful.

Installation Type The software was installed.

Installation

Summary

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ Install Linux DEB package

e |nstall Linux RPM package

314 LinuxDEB

Prerequisites

ODBC Driver for SAP Sybase Adaptive Server Enterprise works under the control of an

ODBC driver manager. ODBC driver manager is not distributed along with our driver and
must be installed separately.
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ODBC Driver for SAP Sybase Adaptive Server Enterprise is compatible with unixODBC driver
manager. Depending on your Linux distribution, you can install the unixODBC driver manager
using one of the following commands:

e For Ubuntu 23 and later versions:

sudo apt-get install libodbcinst2 libodbc2 odbcinst unixodbc

e For other distributions, including Ubuntu 22 and earlier versions:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

If you are using other ODBC driver managers, ODBC Driver for SAP Sybase Adaptive Server
Enterprise will be installed, but it will require manual modification of the configuration files of
these managers.

Installation

Let's consider how to install Devart ODBC Driver on Linux from a DEB package, for example,
on Ubuntu. There are two ways to install the driver: manually using the GUI or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-

click it.

3. In the opened dialog, click Install.
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Ubuntu Software

devartodbcase
New level of Functionality and performance in data access via ODBC

Install

Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise provides a high-performance and feature-rich
connectivity solution for ODBC-based applications to access ASE databases from Windows, macOS, Linux,
both 32-bit and 64-bit. Full support for standard ODBC API functions and data types implemented in our driver
makes interaction of your database applications with Adaptive Server Enterprise Fask, easy and extremely
handy.

Website

Details

Version 2.0.1
Source Unknown
Size 44 MB

Coon free J 3rd party |

This software comes from a 3rd party and may contain non-free components.

If the installation is successfully completed, the Install button changes to Remove.

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

Command-line installation
1. Download the DEB package from the Devart website.

By default, the required package will be downloaded into the ~/Downloads folder (or the
selected one).

2. Run the 'Terminal' program.

3. Navigate to the folder with the downloaded package (if you downloaded the package to a
folder other than ~/Downloads, specify the path to that folder as the cd command

parameter):

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/ase/download.html

Using ODBC Driver 31

cd ~/Downloads/

test@ubuntu:~5% cd ~/Downloads/
test@ubuntu:~/Downloadss I

4. To install the devartodbcase i386.deb on a 32-bit system, use the following command:

sudo dpkg -i devartodbcase_i386.deb

test@ubuntu:~5 cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcase i386.deb |}

5. To install the devartodbcase_amd64.deb on a 64-bit system, use the following command:

sudo dpkg -1 devartodbcase_amd64.deb

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcase amdé64.deb [

The driver is installed successfully.

test@ubuntu:~$ cd ~/Downloads/

test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcase 1386.deb
[sudo] password for test:

Selecting previously unselected package devartodbcase.

(Reading database ... 238832 files and directories currently installed.)

Preparing to unpack devartodbcase i386.deb ...
Unpacking devartodbcase (2.0.1)

Setting up devartodbcase (2.0.1)
test@ubuntu:~/Downloads$ [

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

See also:
e |nstall Linux RPM package

¢ |nstallation on Windows

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

32

ODBC Driver for ASE

3.1.5

¢ |nstallation on macOS

Linux RPM

Prerequisites

ODBC Driver for SAP Sybase Adaptive Server Enterprise works under the control of an

ODBC driver manager. ODBC driver manager is not distributed along with our driver and
must be installed separately.

ODBC Driver for SAP Sybase Adaptive Server Enterprise is compatible with unixODBC driver
manager.

If you are using other ODBC driver managers, ODBC Driver for SAP Sybase Adaptive Server
Enterprise will be installed, but it will require manual modification of the configuration files of
these managers.

Installation

Let's consider how to install Devart ODBC Driver on Linux from an RPM package, for
example, on CentOS. To install the driver, download the .rpm package and install it via the
command line. See the detailed description of these steps below.

1. Download the RPM package from the Devart website.
By default, the required package will be downloaded to the ~/Downloads folder (or the
selected one).

2. Run the 'Konsole' program.

3. Navigate to the folder with the downloaded RPM package (if you downloaded the package
to a folder other than ~/Downloads, you need to specify the path to that folder as the cd

command parameter):

cd ~/Downloads/

[test@centosT7x6e
[test@centosTx6¢
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4. To install the devart-odbc-ase.i386.rpm on a 32-bit system, use the following command:

sudo rpm -ivh devart-odbc-ase.1386.rpm

To install the devart-odbc-ase.x86_64.rpm on a 64-bit system, use the following command:

sudo rpm -ivh devart-odbc-ase.x86_64.rpm

. :E;I-:'I_I':--"-']- LCREm I

5]
o

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

See also:
e |nstall Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS

3.2 Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI
files. This section explains how to use Group Policy to remotely install the ODBC Driver for
SAP Sybase Adaptive Server Enterprise on client computers.
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3.21

The information is organized into the following sections:
e Creating the MST File Using Orca

e Remote Deployment and Activation

e Upgrading Driver Version and License Key

Package Transformation

Creating the MST File Using Orca

To customize the installation of the ODBC Driver for SAP Sybase Adaptive Server Enterprise,
you first need to edit the Windows Installer Package (MSI) by creating an MST file. This will
allow for customized installation of an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration
settings. In our case, the MST file for the ODBC Driver for SAP Sybase Adaptive Server
Enterprise will include the correct license information. This MST file is used together with the
original MSI package in the Group Policy software distribution system.

There are many tools available for customizing MSl file settings, so you can choose the one
that best suits your needs. In this example, we'll be using Orca, which is available as part of
the Windows SDK Components for Windows Installer Developers. For more information
about Orca, visit the official Microsoft website.

To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSl file by selecting Open in the File

menu or click the Open icon on the toolbar below.
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€% Untitled - Orca — [m} P4
File Edit Tables Transform Tools View Help
0O = e
Tables

&% Open *

Lok in: |, soft v| @ T m-
* MName ° Date modified Type Size
5/ DevartODBCSalesforce  8/16/2024410PM  Windows Installer Package 80,5¢

Quick access

Desktop
m
Libraries

Ga

This PC
< >

i File name: |DevartODECSaIesforce v| | Open
Network

Files of type: Installer Database Files (*.msi, “msm, *pcp, “msp)} w Cancel
[]open as read-only

Tables: 0 Mo table is selected. Mo column is selected.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Driver for SAP Sybase Adaptive Server Enterprise.

2. As aresult, the Tables menu on the left side of the main application window will display the
properties of the selected MSl file.

3. Next, navigate Transform -> New Transform.

€% DevartODBCSalesforce.msi - Orca
File Edit Tables Transform Tools View Help

O = Mew Transform
Tables Apply Transform...

AdminExecuteSeq View Patch...

AdminUlSequence

AdvtExecuteSeque Generate Transform...

AppSearch Close Transform...

Binary

CheckBox Transform Properties...

Component

Condition

Control

ControlCondition
ControlEvent
CreateFolder
CustomAction
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4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

& DevartODBCSalesforce.msi (transform
File Edit Tables Transform Tools View Help
0 E-f
Tables Property Value
AdminExecuteSequence UpgradeCode (WEFJ7AZF6-2864-4ADF-A3EB-EEDFT620E45?}

AdminUlSequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Component
Condition

Control
CantrolCondition
ControlEvent
CreateFolder
CustomAction
Dialog

Directory
EventhMapping
Feature
FeatureComponents
File

lcon
InstallExecuteSequence
InstallUlSequence
LaunchCendition
ListBox

Media
MsiFileHash
RadicButton
Reglocator
Registry
RemoveFile
Shortcut

Signature
TextStyle

UlText

Upgrade
_Validation

WIXULLCUSTOMEXITDIALOGOPTIONALCHECKBOX

WixUIRMOption
WIXULINSTALLDIR
IsTrial

ALLUSERS
ProducthName
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT

UseRM
INSTALLLOCATION
Trial

2
Devart ODBC Driver for Salesforce
App.ico

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY
MSIUSEREALADMINDETECT|
Manufacturer
ProductCode
ProductLanguage
ProductVersion
DefaultUIFont
Wixl_Mode

ErrorDialeg

Infolcan

CRLF

TAB

SPACE

AdminProperties
SecureCustomProperties

https://forums.devart.com/viewforum.phpif=35
httne: /A devart mindhe/
Add Row 3 }C Driver for Salesforce 3.4.1 on your computer. Click Mext to continue or Cancel to exit.
Name  Value
?Pmperty ACTIVATIONKEY
Value h32y

Column
Value - Localizable String[0], Required

AWwgealGiBkJOBWTv SARGMED/uquyﬂE'rBTHCxFA#l

WERFOUND; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED

Cancel

In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

¢ Property - enter ACTIVATIONKEY with capital letters only.

e Value - enter the valid OEM license key for the ODBC Driver for SAP Sybase Adaptive

Server Enterprise.

As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with

the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.
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2% DevartODB(CSalesforce.msi (transformed by Untitled) - Orca

File Edit Tables
0O & t
Tables
AdminExecuteSeq
AdminliSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Compenent
Condition
Control
CentrelCondition
ControlEvent
CreateFolder
CustomAction
Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcen
InstallExecuteSequence
InstallUlSequence
LaunchCendition
ListBox

Media

MziFileHash

Property
RadioButton
Reglocator
Registry
RemeoveFile
Shortcut
Signature

Transform | Tools

View Help

New Transform

Apply Transform...

View Patch...

"DIALOGOPTIONALCHECKBOX

Generate Transform...

Close Transform

Transform Properties..
[

ARPPRODUCTICON

ARPHELPLINK

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPMOMODIFY

Manufacturer
PreductCede
Preductlanguage
PreductVersion
DefaultUIFont
WixUI_Mode
ErrorDialog
Infolcon

CRLF

TAB

SPACE
AdminProperties

ARPURLINFOABOUT

SecureCustomProperties

MSIUSEREALADMINDETECTION

Value
{BE17A2F6-2B64-4ADF-A3EB-82DF1620B457}
1
UseRM
INSTALLLOCATION
Trial

2

Devart ODBC Driver for Salesforce

App.ico
https://forums.devart.com/viewforum.php?=53
https://www.devart.com/odbc/

The Setup Wizard will install Devart ODBC Driver for Salesfarce 3.4.1 on your computer. Click Next to continue or Cancel to exit.
NO

0

1

1

Devart
{AEF4136F-3503-4328-9FD4-2883780CC432}
1033

341

WixlJl_Fent_Nermal

Mendo

ErrorDig

info

WIXUI_CUSTOMEXITDIALOGOPTIONALTEXT
ARPNOMODIFY;NETFRAMEWORKA3; NEWERFOUND; OLDESTFOUND: SELFFOUND; WIX_UPGRADE_DETECTED

[ ACTVATIONKEY

+1C/nddkR Hi2P It TPLYdEQt It

6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file

and click Save to apply your settings.

=4

File Edit Tables Transform Teols View Help

D& M FE=mE M

Tables Property Value

AdminExecuteSequence UpgradeCode {BE17A2F6-2B64-4ADF-A3ER-82DF1620B457}

AdminlISequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Compenent
Condition

Contrel
ControlCondition
ControlEvent
CreateFolder
CustomAction

Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcen
InstallExecuteSequence
InstallUISequence
LaunchCenditicn
ListBox

Media

MsiFileHash

Property
RadioButton
Reqlocator
Reqistry
RemoveFile

WixUIRMOption
WIKUI_INSTALLDIR
IsTrial

ALLUSERS
ProductName
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT
WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY

Manufacturer
ProductCode
Productlanquage
ProductVersion
DefaultUIFent
WixU_Mode
ErrorDialog
Infolcon

CRLF

TAB

SPACE
AdminProperties

WIXUI_CUSTOMEXITDIALOGO)|

IMSIUSEREALADMINDETECTIO)

SecureCustomProperties

2% Save Transform As x
Savein: [ soft - @& i E-
* Name - Date modified  Type 5i
No items match your search.
Quick access
- puter, Click Next to continue or Cancel to exit.
Desktop
[ o}
Libraries
This PC
&5 5
Network
File name: » | ‘ Save
Save as type: Windows Installer Transform (* mst) - Cancel | D;WIX_UPGRADE_DETECTED

7. If successful, the encryption message DevartODBCSalesforce.msi (transformed by

DevartODBCSalesforce.mst) - Orca will be displayed at the top of the Orca application

window.
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ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce.mst) - Orca

File Edit Tables Transform Tools View Help

b= A - 2|
Tables ~ | Property Value
AdminExecuteSequence WixUIRMOption UszeRM
AdminUlSequence WIXULINSTALLDIR INSTALLLOCATION
AdvtExecuteSequence I=Trial Trial
AppSearch ALLUSERS 2
Binary ProductMName Devart ODBC Driver for Salesforce
CheckBox ARPPRODUCTICON App.ico
Component ARPHELPLIMEK https://forums.devart.com/viewforum.phpif=53
Condition ARPURLINFOABOUT https://www.devart.com/odbc/
Control WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on you
ControlCondition EXISTS MO
ControlEvent ISVALIDLICENSE 0
CreateFolder ARPMNOMODIFY 1
CustomAction MSIUSEREALADMINDETECTION 1
Dialog Manufacturer Devart
Directory ProductCode {AEF4136F-3503-4528-9FD4-2885780CC432}
EventMapping Productlanguage 1033
Feature ProductVersion 341
FeatureComponents DefaultUIFont WixUl_Font_Mormal
File Wixl_Mode Mondo
lcon ErrorDialog ErrorDlg
InstallExecuteSequence Infolcon info
InstallUlSequence CRLF
LaunchCondition TAE
ListBox SPACE
Media AdminProperties WIXUILCUSTOMEXITDIALOGOPTIOMNALTEXT
MsiFileHash SecureCustormProperties ARPNOMODIFY: NETFRAMEWORKAS;NEWERFOUMND; OLDESTFOUMD; SELFF
[ ACTIVATIONKEY uw7iCODENGAEOFabNziuflXuBv3wbzR2Et] CEDMCTIh+TVwTelHrTrcRLE
RadicButton
Realocator bl B >
Tables: 37 Property - 29 rows Mo celumn is selected.

In case of a positive outcome, the newly created MST file will be located in the folder you

specified, alongside the MSl file.

3.2.2

Deployment and Activation

Installing and Activating Software Remotely

Group Policy automated-program installation is specifically designed for deploying Windows
Installer packages (MSl files). Therefore, when deploying the ODBC Driver for SAP Sybase
Adaptive Server Enterprise using Group Policy, be sure to use the corresponding MSl file for
the ODBC Driver for SAP Sybase Adaptive Server Enterprise.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution
folder:

1. Create a shared network folder on the publishing server.

2. Set the appropriate sharing permissions on this folder to allow read access to the driver

installation package for all domain users.
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3. Download the ODBC Driver for SAP Sybase Adaptive Server Enterprise MSI file, and place

it in the network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Driver for SAP Sybase Adaptive Server Enterprise.

Further in this section, you'll find more detailed information on how to deploy and activate the
ODBC Driver for SAP Sybase Adaptive Server Enterprise on remote client computers using
Group Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then
expand the appropriate option under the Domains node. For this example, we'll select
devart-test.test. Right-click the Domains node, and from the context menu, select Create

a GPO in this domain, and Link it here.

= Group Policy Management - O X
2 File Action View Window Help - &
e 2@ B/E G HE

|, Group Policy Management devart-test.test

v _i\‘ Forest: devart-test.test
v [} Domains
~v 3 devart-testtest . .
s Default Do Create a GPO in this domain, and Link it here...

Status  Linked Group Policy Objects Group Policy Inheritance  Delegation

*ve Directory and 5YSVOL replication for this domain as it relates to Group Policy.

=/ Devart ODE Link an Existing GPO...
[ Wind L

— " o.ws Block Inheritance

2| Domain Cc

;._f Group .Polin Group Policy Modeling Wizard... st test is the baseline domain controller for this domain. Change
F WM Filters Mew Organizational Unit

Ll Starter GPC

& Sites Search in exists for this domain.
5 Group Policy Mad Change Domain Controller... w to gather infrastructure status from all of the domain controllers in this domain.

1« Group Policy Resu Remove

Active Directory Users and Computers...
View >

MNew Window from Here

Refresh
Help

Create a GPO in this domain a
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3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for
the new object and click OK. The new GPO will then appear within the Group Policy
Management container.

For example, let's create a GPO named after the ODBC driver name.

Mew GPO Pt

MName:
| Devart ODBC Driver|

Source Starter GPO:

{none) -

Keep in mind that each ODBC Driver for SAP Sybase Adaptive Server Enterprise Windows
installation package corresponds to one Group Policy Object (GPO), which is important for
managing future software upgrades. To install multiple drivers using Group Policy, you need

to create a separate GPO for each driver you want to deploy.

4. Right-click the new object and select Edit from the context menu.
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5L Group Policy Management - O >
5 File Action View Window Help - &
&9 | nF X & HE
_'s'é Group Policy Management Devart ODBC Driver
v —i\‘F?rT;t: de.\rart-test.test Scope  Details Settings Delegation
v |55 Domains :
v 3 devart-testtest Links
s/ Default Domain Policy Display links in this location: devarttest test ~
s/ Devart ODBC Driver The followina sites_domains and 01 ls are linked to this GPO:
s Windows Update Server Edit... h — — -~
== ; arce: in able at
— Domain Controllers .
~ [ Group Policy Objects | (e No ‘Yes devart4est test
= Default Demain Controllers Pc i Enable
=[ Default Domain Policy Save Report... R
' Devart ODBC Driver e N !
=] Windows Update Server )
= WM Filters Mew Window from Here sy to the following groups, users, and computers:
a9
a Starter GPOs Delete
B Sites Rename
565 Group Policy Modelin
i P Y 9
4 Group Policy Results Eelie<h
Help we Properties
]
WMI Filtering

This GPO is linked to the following WMI filtter:

Open the GPO editor

5. In the left pane of the Group Policy Management Editor, navigate to Computer
Configuration --> Policies --> Software Settings --> Software installation. Your
current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.
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1L Group Policy Management -
i FI|E . A8 A Llal
E[ Group Policy Management Editor — O *
|
——— File Action View Help
15 Grou
vAarRe=® 2@ E 6= HE
¥ '5| 5 Devart ODBC Driver Name Version Deployment st.. Source
™ v i Computer Configuration
w || Policies
~ [ Software Settings
Software installation
» [ Windows Settings MNew > Package... b
> [ | Administrative Templat )
= View ¥
» || Preferences
v i, User Configuration Paste
< L
> 4 » || Policies Refresh
s > [ ] Preferences
[ Export List...
Properties
Hel
< =l
IL
Adds a package.
WMI Filtering

This GPO is linked to the following WMI filter:

6. In the Group Policy Management Editor dialog that opens, select the desired MSI

installation file and click Open.

& Group Policy Management —

s File fmtimm  lfim  Ufiecles Llale

| & Group Policy Management Editor - o X
== N
/1| =
|5 Grou [ Open x
e -ﬁ;_ T « test-ad-del » soft v 0 Search soft el
A
o - ==
Organize « Mew folder B== ~ [ o oft\DevartODBC
[&] Pictures ~ Name Date modified Type
B Videos 15! DevartoDBC 8/19/20245:50 PM  Windows Installer Pack
‘am Local Disk (C:)
|_ﬂ Metwork
_ﬁ L 4 >
i File name: |De\.rartODBC v| Windows Installer packages (*.r
< >

WMI Filtering
This GPO is linked to the following WM fitter:
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7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSl file, such as creating the MST file in Orca.

Deploy Software

Select deployment method:

Published

Select this option to configure the Published or Assigned options,
and to apply modffications to a package.

Cancel

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply

the settings.

\&l Group Policy Management
2 File Action View Window Help
e @ X G|

54 Group Policy Management Devart OUBL HriverFroperties

|
Fi t: devart-test.test P
e i ?res SvartesLies General Deployment Upgrades Categores Modfications  Security
~ |55 Domains
w 335 devart-test.test Modffications or transforme allow you to customize the package and are
4 Default Domain Policy applied to the package in the order shown in the following list - O
sz Devart ODBC Driver
EEJ.’ Windows Update Server Move Up
= | Domain Controllers
= Group Policy Objects Move Down ion  Denlovment st. Source
& WMI Filters *
] Starter GPOs
& Sites P L « test-ad-decl » soft v O Search soft -l
s Group Policy Modeling
2 Group Policy Results Organize »  Mew folder - W @
&=/ Pictures L MName Date modified  Type
Removel [ Videos [ DevartODBC.mst 8/16/202440... MST File
s Local Disk (C)
Important! Do not press OK uf
comectly. For more informatiol
then dlick What's this? = Network
v £ >
(RN B0 evart ODBC . mist] v| Windows Installer transform pa
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9. If configured correctly, the Group Policy Management Editor window should look as

follows:

'=[ Group Policy Management Editor
File Action View Help
e HEEC= HE
- - =~
(5[ Devart ODBC Driver * || Mame Version Deploymen... Source
v (i Computer Configuration
w || Policies
~ [ | Software Settings
Software instal
| Windows Settings
| Administrative Ter
| Preferences

w 4 User Configuration w
< >

Devart ODBC Driver 3.4 Assigned Wtest-ad-dcT\soft\DevartODBC.msi

Client-Side Actions

For the ODBC Driver for SAP Sybase Adaptive Server Enterprise to be successfully installed

on remote client machines, all domain users must restart their computers after logging in for
the first time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.

To verify, open the ODBC Data Source Administrator on the client's machine and add the
deployed ODBC driver.
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Create Mew Data Source

>
Select a driver for which you want to set up a data source.
MName Version Col
Devart ODBC Driver 3.04.01.00 De
SGL Server 10.00.15041.01 M

< Back Cancel

All information on the deployed driver is accessible upon clicking the About tab.
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Devart ODEC Driver Cenfiguration X

General Advanced Settings Security Settings  Tracng License About

Devart ODBC Driver
Desktop License

Version:

devart

5.3.0
Web:

www, devart, comfodbc

E-mail:

support@devart.com

ODBC Driver

© 2015-2025 Devart. All right reserved,

Test Connection . Cancel

Similarly, the valid license key will be automatically activated after the successful installation
of the ODBC Driver for SAP Sybase Adaptive Server Enterprise.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

See Also
e Creating the MST File Using Orca

e Activating on Windows - ODBC Driver for SAP Sybase Adaptive Server Enterprise

¢ License Information - ODBC Driver for SAP Sybase Adaptive Server Enterprise

3.23 Software Upgrade

Automatic Software Update Using Group Policy

If the ODBC Driver for SAP Sybase Adaptive Server Enterprise was initially deployed through
Group Policy, it can be easily updated to a newer version. Follow the steps below to update
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both the ODBC Driver for SAP Sybase Adaptive Server Enterprise and the license to newer
versions on all remote computers in the domain.

1. Download the ODBC Driver for SAP Sybase Adaptive Server Enterprise installation MSI file

of a newer version and place it in the shared network folder.

2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.
ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce_new_key.mst) - Orca — [m] *
Eile Edit Tables Transform Tools View Help
= #
Tables ~ | Property WYalue
AppSearch UpgradeCode {8E17A2F6-2B64-4ADF- ASEB-82DF 16208457}
Binary WIXUI_CUSTOMEXITDIALOGOPTIOMALCHECKBOX 1
CheckBox WixUIRMOption UseRM
Component WIXUI_INSTALLDIR INSTALLLOCATION
Cendition IsTrial Trial
Control ALLUSERS 2
ControlCondition ProductMame Devart ODBC Driver for Salesforce
ControlEvent ARPPRODUCTICON App.ico
CreateFolder ARPHELPLINK https://forums.devart.com/viewforum.php?f=33
CustomAction ARPURLINFOABOUT https://www.devart.com/odbc/
Dialeg WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.3.0 on your computer, Click Next to continue
Directory EXISTS MO
EventMapping ISVALIDLICEMSE ]
Feature ARPNOMODIFY 1
FeatureComponents MSIUSEREALADMIMDETECTION 1
File Manufacturer Devart
lcon ProductCode {73ABASBS-E56E-4828-BE3B-B6FDABSECS39)
InstallExecuteSequence ProductLanguage 1033
InstallUlSequence ProductVersion 3.5.0
LaunchCondition DefaultUIFont Wixl|_Font_Normal
ListBox WixUl_Mode Mondo
Media ErrorDialog ErrorDig
MsiFileHash Infolcon info
| Property CRLF
RadicButton TAB
Reglocator SPACE
Reqistry AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIOMALTEXT
RemoveFile SecureCustomProperties ARPMOMODIFY:NETFRAMEWORK45;NEWERFOUMD; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
Shortcut ACTIVATIONKEY ulw7iCODENGAEDFabNziuflXuBv3wbzRIEH1 CADMCTIh+TVw/el HrTrc1RLFrwmdCSawbSwaRMiXara3 kDofi2d
Signature
TextStyle
UlText
Upgrade
_Validation v | < >
Tahles: 37 Pronerty - 79 rows. Mo column is selected

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for SAP Sybase Adaptive Server Enterprise.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for SAP

Sybase Adaptive Server Enterprise Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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I . — O X
2) Properties ? X
F
H General Deployment Upgrades Categories Modffications  Security
il
fi Packages that this package will upgrade: Add Upgrade Package 4
1 Choose a package from BCSalesforce...
(®) Cumrent Group Policy Object (GPO)
() A specific GPO:

Browse...

Package to upgrade

Devart ODBC Driver for Salesforce (2)

Add... Remove

Required upgrade for existing packages

Packages in the cument GPO that will upgrade this package:

() Uninstall the existing package, then install the upgrade package
(®) Package can upgrade over the existing package

ok Conce

Make sure to select the following check boxes while adding the package:

e Current Group Policy Object
e Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.
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Browse for a Group Policy Object

Domains/OUs  Sites Al

< |
|_'::>
g
[
1

Look in: |5 devart test test

All Group Paolicy Objects stored in this domain:

Mame

|=[ Defautt Domain Controllers Policy
\=[ Defautt Domain Policy

E Devart ODBC Driver for Salesforce
=] Windows Update Server

6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modffications  Security

Packages that this package will upgrade:

Upgrade Devart ODBC Driver for Salesforce

Upgrade Devart QDBC Driver for Salesforce (2]

Add... Bemove

Required upgrade for existing packages

Packages in the cumert GPO that will upgrade this package:

Corcs

51

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the

MST file.

We have already created a new MST file with a new license key in Step 2.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modifications  Security

Maodffications or transforms allow you to customize the package and are
applied to the package in the order shown in the following list:

Modffications:

West-ad-de 1soft \DevatQDBC Salesforce_new keym Mave Up

Move Down

oo

Impaortart! Do not press OK until all transforms are added and ordered
comectly. For mare information, right-click on the Modfications list box, and
then click What's this?

Corcs

8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

= Group Policy Management Editor
File Action View Help

as Hm EQ HE

- Devart ODBC Driver for Salesfor|| Name Version Deploymentst.  Source
v i Computer Configuration Devart ODBC Driver for Salesforce 34 Assigned \\test-ad-dc\soft\DevartODBCSal...
v [ Polides Devart ODBC Driver for Salesforce (2) 35 Assigned \\test-ad-dc1\soft\DevartODBCSal..

v [ Software Settings
Software installat

| Windows Settings
| Administrative Templ

| Preferences

- n".; User Configuration
_ Policies
_ Preferences

Once the GPO configuration on the server is complete, the ODBC Driver for SAP Sybase
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Adaptive Server Enterprise will automatically update to the latest version each time a client
computer restarts.

Client-Side Actions

To update the ODBC Driver for SAP Sybase Adaptive Server Enterprise to a newer version
on remote client machines, all domain users must restart their computers after their first
login.

If successful, both the driver and the license key will be automatically updated to the new
version on remote computers. For detailed instructions on how to view the technical details of
the ODBC Driver for SAP Sybase Adaptive Server Enterprise after upgrading, refer to Client-
Side Actions.

See Also
e Creating the MST File Using Orca

e Remote Deployment and Activation - ODBC Driver for Microsoft Access

e Activating on Windows - ODBC Driver for SAP Sybase Adaptive Server Enterprise

e License Information - ODBC Driver for SAP Sybase Adaptive Server Enterprise

3.3 Product Activation

See how to activate Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise:
e Obtaining Activation Key

e Activation on Windows

e Activation on macOS

e Activation on Linux

e Where to see the license information

3.3.1  Obtaining Activation Key

Follow these steps to obtain your product activation key:

¢ From the Customer Portal:

1. Open the Customer Portal and sign in.
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2. On the Product licenses page, select the driver.

3. Click Copy to clipboard to copy the activation key.

Product licenses
g ODBC Driver Export license details
LicenselD Owner Assigned Type
> 375E-422F-001 email@example.com NOT ASSIGNED Single

Activation key:

nkLId7irC4nhZdUFN/6gbWxHYJhCHIyILz/195Nu80z TpScTIff 2pFg+LImLxlyGXPThgvA+D4jRhwwVEBvXBEVZn
azsgkJiZwohsuG3+/Biy11MHUNZ htrpM91c3119YwocKuaB84NeG871C79ddalFfPumci+D290t829+16tnCSPwq V7
8Q3GS1ZIoWYwWFIiJiQvaN1cSYnep8SS53/3InHiF CaakdiE46WdbgQrtmLNfHU+ZwvFDR3bTFKcEvgGoHITCh
VAWDR44AxO1gBa==

Copy to clipboard

Assign this license to:

Store Support

¢ From the registration email:
1. Locate the registration email you received from Devart after installing the driver. This
email contains a Purchased or Trial activation key.

2. Copy the activation key.

See also:

e Activation on Windows

e Activation on macOS

e Activation on Linux

3.3.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver, perform the following steps.
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You need to activate the driver even for the trial version.
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.

'-RT. QDBC Data Source Administrator (84-bit) =

User DSN  System DSN  File DSN  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QDBC Driver for Azure_x32 32bit Devart ODBC Driver for SAL 5

QDBC Driver for BigClommerce_x32 32-bit Devart ODBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynamr

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebirc Configure. ..

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Ed-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQI ¥
< >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Inthe Create New Data Source dialog, select the installed driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialog, navigate to the License tab, and click Input Activation Key.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 57

Devart ODEC Driver Cenfiguration

General Advanced Settings Security Settings  Tracding

License Information

Mot registered

You may register ODEC Driver at
https: /fwww, devart, comfodbcf<driver=fordering. htmil

s

License About

Get Purchased or Trial Activation Key...

Input Activation Key...

Test Connection Ok

Cancel

5. Here, you can activate the driver using one of the following methods:

e Enter an activation key: Paste your activation key into the corresponding box.

e Load an activation file: Click Load Key and select the file that contains the activation

key.

You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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Devart ODBC Driver Configuration x
General Advanced Settings Security Settings  Tracing License  About

License Information

Mot registered

You may register ODBC Driver at
https: ffwww.devart, comfodbc/<driver=fordering. html

-

Input Activation Key >

Activation Key

U 1w FCODENGAEDFgbMzjuck IzVxGPY kR Y IHE TTv

+th4-+CROPh&PZARMS3pY pPasaPTivaeiQ 2bi 7Fig Y yHAI FITkhb /dkazwWog 4t oxSUZibzgVyAuSz 2DgX FREM
AJjhZj0+hPlajyghTIEy Ez TDxe0Q X tspppd SR Ik30uAIb fIdOWenAIQMNzQGivDgFSx fdz09B 0 Inrhg 59KEg fic
powTZIWa mmmTokyCkLICx5SomSEi9ghS8gWchDug/Slz8 kxS G AWKSGCHY 15gWYr
+/RZOF{¥gALILIOt 13NA |

Load Key... Cancel

Get Purchased or Trial Activation Key...

Input Activation Key... .

Deactivate Product

Test Connection - (8.4 Cancel

6. Click OK.

3.3.3 Activation on macOS

Driver Activation After Installation

If you didn't activate Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise during
installation, you can activate it later using one of two methods:

¢ Online via a console application (for Perpetual and Subscription licenses).

¢ Offline with an activation file (only for Perpetual licenses).

You need to activate the driver even for the trial version.
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Activate Online via a Console Application

To activate the driver over the internet using a console application, follow these steps (this
method works for both Perpetual and Subscription licenses):

1. In the console, go to the folder where the driver was installed. The default installation path
iS /Library/ODBC/Devart/ASE.
2. Optional: To open the Customer Portal in your browser and locate your activation key, run

the following command:

./aseodbcactivator -g

Alternatively, you can find your activation key in the registration email.

3. Run the activation command with superuser privilege, providing either the driver activation

key or the path of the file with the key:

¢ To activate using the activation key:

sudo ./aseodbcactivator -a <activation_key>

Replace <activation_key> with the driver activation key.

¢ To activate using a file:

sudo ./aseodbcactivator -a <file_path>

Replace <file_path> with the full path of the file containing the driver activation key.

When the process is complete, the driver is activated, and the License Summary is displayed
in the console.

Activate Offline With an Activation File

To activate the driver offline (only for Perpetual licenses), follow these steps:

1. Go to the folder where the driver was installed. The default installation path is /Library/

ODBC/Devart/ASE.

2. In that folder, create a file with the activation.key name.
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3.34

3. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

4. Save the file.

The driver gets activated.

See also:

e Activation on Windows

e Activation on Linux

Activation on Linux

Driver Activation After Installation

If you didn't activate Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise during
installation, you can activate it later using one of two methods:

¢ Online via a console application (for Perpetual and Subscription licenses).

¢ Offline with an activation file (only for Perpetual licenses).

You need to activate the driver even for the trial version.

Activate Online via a Console Application

To activate the driver over the internet using a console application, follow these steps (this
method works for both Perpetual and Subscription licenses):

1. In the console, go to the folder where the driver was installed. The default installation path
is:
¢ For the DEB package: /usr/share/devart/odbcase
¢ For the RPM package: /usr/local/devart/odbcase

2. Optional: To open the Customer Portal in your browser and locate your activation key, run

the following command:
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./aseodbcactivator -g

Alternatively, you can find your activation key in the registration email.

3. Run the activation command with superuser privilege, providing either the driver activation

key or the path of the file with the key:
¢ To activate using the activation key:

sudo ./aseodbcactivator -a <activation_key>

Replace <activation_key> with the driver activation key.

¢ To activate using a file:

sudo ./aseodbcactivator -a <file_path>

Replace <file_path> with the full path of the file containing the driver activation key.

When the process is complete, the driver is activated, and the License Summary is displayed
in the console.

Activate Offline With an Activation File

To activate the driver offline (only for Perpetual licenses), follow these steps:

1. Go to the folder where the driver was installed. The default installation path is:
e For the DEB package: /usr/share/devart/odbcase
e For the RPM package: /usr/local/devart/odbcase

2. In that folder, create a file with the activation.key name.

3. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

4. Save the file.

The driver gets activated.

See also:

e Activation on Windows
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e Activation on macOS

3.3.5 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.

'-;- QODBC Data Source Administrator (84-bit)

User DSN  System DSN  File DSN  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driver for SAL 5

QODBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QODBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynarmr

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebirc Configure...

QODBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QODBC Driver for Mongo DB Ed-bit Devart ODBC Driver for Monge
QODBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySGL 32bit 32-bit Devart ODBC Driver for MySQI ¥
< >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Select the driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialogue, navigate to the License tab to view the license details.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

3.4 Connecting to SAP ASE

See how to connect to the ODBC Driver for SAP Sybase Adaptive Server Enterprise:
¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration

3.41 Windows

Windows DSN Configuration
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After installing the driver, create a DSN for ASE in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.

* Type oDBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe t0 create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise and click

Finish. The driver setup dialog will open.

5. Enter the connection information in the appropriate fields.
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Devart ODEC Driver for Adaptive Server Enterprise Configuration X

General Advanced Settings Security Settings  Tradng License  About

Data Source Mame  Adaptive Server Enterprise

Description Devart ODBC Driver for Adaptive Server Enterprise
Server ASEserver ~ | Port 5000
Database testdb

User ID 53

Password I1T ] B szve Password

Test Connection . Cancel

6. You can test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also

Connection Options

34.2 Mac

macOS DSN Configuration

After the driver is installed, DSN with the name DEVART _ASE is created. You can use it to
test a connection with ASE server. For this, perform the following steps:

1. Run the iODBC utility of the required bitness. Find the DEVART_ASE section and click the
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Configure button:

[ ] iODBC Data Source Administrator (64-Bit Edition)

- User DSN File DSN

ODBC Drivers Connection Pooling Tracing About

System Data Sources
Mame Description
DEVART_ASE
DEVART_FIREBIRD -
DEVART_INTERBASE -
DEVART_MONGODB -
DEVART_MYSQL -
DEVART_ORACLE -
DEVART POSTGRESQL -
DEVART_REDSHIFT -
DEVART_SQLAZURE -
DEVART_SQLITE -
DEVART SQLSERVER -

E Source connection information.

Driver Add
Devart QDBC Driver for ASE

Devart ODBC Driver for Firebird Hemaove
Devart ODBC Driver for InterBase .
. Configure
Devart ODBC Driver for MongoDB ————
Devart ODBC Driver for MySQL
Devart ODBC Driver for Oracle
Test

Devart ODBC Driver for PostgreSC
Devart ODBC Driver for Amazon R
Devart ODBC Driver for SQL Azure
Devart ODBC Driver for SQLite

Devart ODBC Driver for SAL Serve

System Data Source Names create systems-wide ODBC Data Mames that resolve to Data

Cancel

2. In the appeared dialog, specify the required connection settings and click OK.

67
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® O Setup of DEVART_ASE

Data Source Name (DSN) | DEVART_ASE
Comment

Keyword Value

Data Source ASEserver

Port 5000

Catabase master

User ID sa

Password TEEEEE

+ -

3. Now click the Test button to establish a test connection to your data source.
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@ iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE Devart ODBC Driver for ASE

DEVART_FIREBIRD - Devart ODBC Driver for Firebird Remova
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB| ———
DEVART_MYSQL - Devart ODBC Driver for MySQL
DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSe Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SOL Serve

_____ System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
E Source connection information.

See Also

Connection Options

3.4.3 Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name DEVART_ASE is
created. You can use it to test the connection with the ASE server. For this, perform the

following steps:
1. Open the odbc.ini file located in the /etc folder. Find the DEVART_ASE section and specify
the required connection settings:

User ID=<your ASE user name>
Password=<your ASE password>
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Server=<your ASE server address>
Port=<your ASE port>
Database=<your ASE database name>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_ASE

test@ubuntu:~% isql -v DEVART_ASE

Connected!

sql-statement
help [tablename]

See Also

Connection Options

3.5 Connection String Parameters

SAP ODBC Connection String Parameters

The following table lists the connection string parameters for SAP Sybase Adaptive Server
Enterprise.

Paramet

Description
er
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Server Serves to supply the server name for login.

Port Used to specify the port number for the connection. 5000 by default.
Database |Used to setthe name of the database

User ID Used to supply a unique User ID for login.

Password Used to supply a password for login.
Advanced Settings

Adaptive Server Enterprise cannot distinguish SQL_CHAR from
SQL_VARCHAR, SQL_WCHAR from SQL_WVARCHAR, and SQL_BINARY from
SQL_VARBINARY when preparing an SQL statement. This may break

AllowFixedT compatibility with some third-party tools. To prevent compatibility issues,

ypes the driver always returns SQL_VARCHAR instead of SQL_CHAR, SQL_WVARCHAR
instead of SQL_WCHAR, and SQL_VARBINARY instead of SQL_BINARY in
metadata. If you want to change this behavior and return fixed data types
in metadata, set the parameter to True.

AllowNullst
ringsInMeta SOMe parameters don't accept null values when retrieving metadata. If a

data third-party tool passes a null value to such a parameter, the driver returns
EmptyStringan error. By default, these options are enabled for compatibility with such

sAsNullInMe third-party tools.
tadata

ConnectionT The time (in seconds) to wait for a connection to open before terminating

imeout an attempt. The default value is 15.

The Internet Protocol Version.
ivIPv4

The default value. Internet Protocol Version 4 (IPv4) is used.
IP Version |iyIpve

Internet Protocol Version 6 (IPv6) is used.
ivIPBoth
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Either Internet Protocol Version 6 (IPv6) or Version 4 (IPv4) is used.
Note: When set to ivIPBoth, a connection attempt is made via IPv6 if itis
enabled in the operating system. If the connection attempt fails, a new

connection attempt is made via IPvA4.

MultipleCon Enables or disables the creation of additional connections to support

nections  |concurrent sessions, commands and rowset objects.

Sets the behavior corresponding to the ODBC specification version
expected by a third-party tool. The behavior of the ODBC driver can be
changed by calling the sQLSetEnvAttr function to set the
SQL_ATTR_ODBC_VERSION environment attribute. Some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the needed version, or pass an incorrect value. In this
case, the behavior can be explicitly set in the connection string.

ODBC 0

2y The default value. ODBC behavior is determined by a third-party tool.
2

ODBC 2.x behavior is explicitly set.
3

ODBC 3.x behavior is explicitly set.
To avoid conflicts in procedures and queries that contain reserved words,

you should use the QuotedIdentifier parameter. The Quotedldentifier

QuotedIdent ) ) )
e parameter tells Adaptive Server to consider any character string enclosed
irier

in double quotes as an identifier. If this parameter is disabled (by default),

ASE considers everything inside the double quotes as a simple string.

RegionalDat : , :
810oNa Tt Ehables the use of local regional settings when converting dates and

eTimeSettin| _
times to strings.
gs

RegionalNum Enables the use of local regional settings when converting numbers to
berSettingssnings_

Sets the string value types returned by the driver as Default, ANSI, or
Unicode.

SiiliE Default

Types
The driver defines the string types.
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Ansi

All string types are returned as SQL_CHAR, SQL_VARCHAR, and

SQL_LONGVARCHAR.

Unicode

All string types are returned as SQL_ WCHAR, SQL_WVARCHAR, and

SQL_WLONGVARCHAR.

Note: Set the parameter to Ansi or Unicode if your third-party tool supports

only ANSI or Unicode strings.

Allows the application to retrieve and display all available catalogs
AllCatalogs|(databases or schemas, depending on the database system) from the

connected server.

ASE ODBC Connection String sample

DRIVER={Devart ODBC Driver for ASE};User
ID=sa;Server=ASEserver;Data Source=master;Port=5000

See Also:
e SSL Connection

e SSH Connection

e HTTP Tunneling

3.6 Secure Connections

This section describes how to establish secure connections to ASE with ODBC Driver for
ASE.

e SSL Connection

e SSH Connection

e HTTP Tunneling
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3.6.1

SSL Connection

Connecting to ASE Using SSL

SSL (Secure Sockets Layer) is a standard protocol for secure access to a remote machine
over untrusted networks. It runs on top of TCP/IP to secure client-server communications by
allowing an SSL-enabled client to authenticate itself to an SSL-enabled server and vice versa.
During server authentication, an SSL-enabled client application uses standard techniques of
public-key cryptography to verify the server's identity by checking that the server's certificate
is issued by a trusted certificate authority (CA) and proves the ownership of the public key.

Conversely, SSL client authentication allows the server to validate the client's identity. The
client and server can also authenticate each other using self-signed certificates. However,
you will rarely want to use a self-signed certificate, except for an Intranet or a development
server. After establishing an SSL connection, the client and server can exchange messages
that are symmetrically encrypted with the shared secret key. SSL is the recommended
method to establish a secure connection to ASE due to its easier configuration and higher
performance, compared to SSH.

See the ASE documentation for more information on how to set up SSL in ASE and Open

Client and configure SSL .

To establish an SSL connection to ASE, specify the SSL certificates and client private key:
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Devart ODEC Driver for Adaptive Server Enterprise Configuration X

General Advanced Settings Security 5ettings  Tracing License  About
551 Optiens 554 Options  HTTP and HTTPS Cptions
[ [
CA Certificate C:'cacert.pem
Certificate C:\dient-cert.pem
Key C:\dient-key.pem

Key Password

B 1gncre Server Certificate Validity
B Ignore Server Certificate Constraints
|| Trust Server Certificate

[ J1gnere Server Certificate Insecurity

Test Connection Cancel
SSL Options
Option Description
Use SSL Enables SSL connections.

CA Certificate
Certificate

Key

Key Password

Ignore Server Certificate Validity

The CA certificate.
The client certificate.
The private client key.

The password for the private client key.
Leave it empty if the client key is not

encrypted.

Specifies whether to check the server
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3.6.2

certificate validity period during an SSL

handshake. The default value is True.

Specifies whether to verify the server

certificate for compliance with constraints
Ignore Server Certificate Constraints .
during an SSL handshake. The default

value is True.

Specifies whether to verify the server
certificate during an SSL handshake. By
default, the driver verifies the server

Trust Server Certificate ) o
certificate. When the option is set to True,

the driver will bypass walking the certificate
chain to verify the certificate.
Specifies whether to verify the security of

Ignore Server Certificate Insecurity |the server certificate's signature during an

SSL handshake. The default value is False.

Sample SSL Connection String

DRIVER={Devart ODBC Driver for ASE};Data
Source=myServer;Port=myPort;Database=myDatabase;User
ID=myUsername;Password=myPassword;SSL=True;SSL CA Cert=C:
\myCaCertificate.pem;SSL Cert=C:\myClientCertificate.pem;Key=C:
\myPrivateClientKey.pem

SSH Connection

Connecting to ASE Using SSH

This section discusses how to connect to ASE through SSH. Secure Shell (SSH) is
cryptographic network protocol for secure remote login, command execution and file transfer
over untrusted networks. SSH uses client-server architecture, connecting an SSH client with
an SSH server. The client and server authenticate each other and pass commands and
output back and forth. To secure the transmitted data, SSH employs forms of symmetric
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encryption, assymetric encryption, and hashing.

In symmetric key cryptography, a single key is used by the sending and receiving parties to
encrypt and decrypt messages. Assymetric encryption requires two associated keys, the
private key and the public key. The public key encrypts messages that can only be decrypted
by the private key. The public can key can be freely shared with anyone to autenticate another
party, while the private key must be kept secret. The client public key must be stored in a
location that is accessible by the SSH server to authenticate the server by the client;
conversely, the server public key must be placed on the client side to authenticate the client
by the server. Assymetrical encryption is used during the initial key exchange process to
produce the shared secret (session key) to encrypt messages for the duration of the session.

The SSH server listens on default port 22 (this port can be changed) for incoming TCP
connections. The SSH client begins the initial TCP handshake with the server and verifies the
server's identity. The client and server agree upon the encryption protocol and negotiate a
session key. The server then authenticates the client and spawns the right environment. The
ODBC driver for ASE implements the SSH client feature to connect to the SSH server on the

remote machine at the specified port. The SSH server authenticates the client and enables
the driver to establish a secure direct connection to ASE. Below is a simplified diagram
representing the SSH tunneling.

Devart ODBC Untrusted

L DB Server
Driver Network SSH Server
A— —
resr 8 | —
L e 2 [eeer |
rrrr s | [rear w ]
rear_» ]

Note: You don't have to install the SSH client since ODBC Driver for SAP Sybase Adaptive

Server Enterprise implements the SSH client functionality.

SSH Connection Options

To establish an SSH connection to ASE, specify the connection parameters on the ssH
Options tab under security Settings.
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S5 Options  55H Options  HTTP and HTTPS Cptions

Devart ODBC Driver for Adaptive Server Enterprise Configu...

General Advanced settings Secure settings  License About

Use 55H

Host name | 192,168.50. 160
Port |22

User name |55HUser
Password | FEBBEES

Client private key |Pri'-.-'ateKE1,-'.pem

Password for key |"'""

Server public key |F‘u|:u|i|:|<.ey.pem

Storage path |D: Keysl

Test Connection ver Cancel

SSH Connection Options:
Option

Use SSH

SSH Host name

SSH Port

SSH User Name

SSH Password

Description

Enables SSH connections.

The host name or IP address of the SSH

server.
The SSH port number (22 by default).
The username for the account on the SSH

server.

The password for the account on the SSH
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server.

The filename of the client private key for

SSH Client Key
key-based authentication.

SSH Client Key Password The passphrase for the client private key.
SSH Server Key The filename of the SSH server public key.

The directory where the encryption keys are

SSH Storage Path
stored.

Sample Connection String:

DRIVER=Devart ODBC Driver for ASE;Data
Source=myHost;Port=myPort;Database=myDatabase;User
ID=myUsername;Password=myPassword;Use SSH=True;SSH Host
name=mySshHost;SSH User Name=mySshuUsername;SSH
Password=mySshPassword;SSH Client Key=myPrivateClientKey.pem;SSH
Client Key Password=myClientKeyPassphrase;SSH Server
Key=myPubl1icServerKey.pem;SSH Storage Path=myDirectorywithKeys

3.6.3 HTTP Tunneling

Connecting to ASE Using HTTP Tunneling

This section discusses how to connect the ODBC driver to ASE through an HTTP tunnel. If
you need to connect to ASE in conditions of restricted connectivity, e.g. when a database
server is hidden behind a firewall, or you need to transmit private network data through a
public network, you can set up an HTTP tunnel to create a direct network link between two
locations. The tunnel is created by an intermediary called a proxy server.

When ASE server is hidden behind a firewall, the client is not able to connect to the server
directly on a specified port. If the firewall allows HTTP connections, you can use the ODBC
driver with a properly configured web server to connect to the database server. The driver
supports HTTP tunneling based on the PHP script.

A possible scenario of using HTTP tunneling: the client needs to access the database of a
website from a remote machine, but access to the designated port of the database server is
forbidden — only connections on the HTTP port 80 are allowed. To establish a connection in
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this situation, you must deploy the tunnel.php script, which is distributed with the driver, on
the web server. It enables access to the database server through an HTTP tunnel. The script
must be accessible through HTTP. You can verify the script accessibility using any web
browser. The script file is located in the "C:\Program Files (x86)\Devart\ODBC\ASE\http
\tunnel.php" folder. The web server must support PHP 5 or later.

To set up an HTTP tunnel, specify the connection parameters on the HTTP and HTTPS Options
tab under security Settings.

Devart ODBC Driver for Adaptive Server Enterprise Configuration et
General Advanced Settings Security Settings  Tracdng License About

5SL Options  SSH Options  HTTP @nd HTTPS Options

B8 Use HTTP or HTTPS

URL http:/fserver fiunnel.php
Authentication Type  Bearer Token e
HTTF Token 4f9e0albab124579bfSbTes

|| Trust Server Certificate
Proxy Options
Host Mame

Port 0]

User Mame

Password

Test Connection . 0K Cancel

HTTP Tunneling Options

Option Description
Use Http | Enables HTTP tunneling.

Http Url | The URL of the PHP script for HTTP tunneling.
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Http User |The username for the password-protected directory that contains the
Name HTTP tunneling script.

Http The password for the password-protected directory that contains the
Password  |HTTP tunneling script.
Http Trust SPecifies whether to verify the server certificate during an SSL
Server handshake. When True, the driver bypasses walking the certificate chain
Certificateto verify the certificate. The default value is False.
Stores a token for HTTP authorization. The Token property holds the
Http Token Bearer token used to access the protected directory that contains the
HTTP tunneling script.
Http Specifies the HTTP authorization type. The AuthenticationType property

Authenticat specifies the HTTP authorization type used to access the secure directory
ion Type thatcontains the HTTP tunneling script..

Sample Connection String Using HTTP Tunneling

DRIVER=Devart ODBC Driver for ASE;Data
Source=myHost;Port=myPort;Database=myDatabase;User
ID=myUsername;Password=myPassword;Use Http=True;Url=https://host/
folder/tunnel.php;Http User Name=myHttpUsername;Http
Password=myHttpPassword

Connecting Through HTTP Tunnel and Proxy Server

The HTTP tunneling server may be not be directly accessible from the client machine. In this
case, you need to additionally provide connection information for the proxy server.
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Devart ODEC Driver for Adaptive Server Enterprise Configuration X
General Advanced Settings Security Setlings  Tradng License About
SSL Options  SSH Optiong  HTTP and HTTPS Options

B Use HTTP or HTTPS

URL http: ffserver ftunnel.php
Authentication Type  Bearer Token e
HTTP Token H2elalash 124579bf5b7e7

[ Trust Server Certificate

Proxy Options

Host Mame 10.0.0,1

Port 3128

User Mame ProxylUser
Password TIITITTITITITIY]

Test Connection . Cancel

Proxy Options

Option Description

Proxy Host Name The proxy hostname or IP address.
Proxy Port The proxy port.

Proxy User Name The proxy username.

Proxy Password The proxy password.

Sample Connection String Using HTTP Tunneling and Proxy Server

DRIVER=Devart ODBC Driver for ASE;Data
Source=myHost;Port=myPort;Database=myDatabase;User
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ID=myUsername;Password=myPassword;Use Http=True;Url=https://host/
folder/tunnel.php;Http User Name=myHttpUsername;Http
Password=myHttpPassword;Proxy Host Name=myProxyHost;Proxy
Port=myProxyPort;Proxy User Name=myProxyuUsername;Proxy
Password=myProxyPassword

Additional Information

There is one more way to tunnel network traffic. The Secure Shell forwarding, or SSH, can be
used for data forwarding. However, SSH is designed to encrypt traffic rather than traverse
firewalls. The Connecting via SSH document describes how to set up an SSH connection in
the ODBC Driver for SAP Sybase Adaptive Server Enterprise.

Note that traffic tunneling or encryption increases the CPU and bandwidth usage. It is
recommended that you use direct connection whenever possible.

3.7 Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access iODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When

accessing a data source from an application like Excel through the ODBC driver for ASE, you

may get an error message saying that the driver is unable to create a file.

Note: All third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the
Apple logo).
2. Select Utilities > Terminal.

3. In the Terminal window, enter csrutil disable.
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3.8

[ ] O Terminal — -bash — 80x 24

-bash-3.2& csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes to take effect.

-bash-3.2# rebootf]

4. Restart your computer.

5. Enter csrutil status to check the status of SIP.

& & 3y test — paserver — -bash — BOx24

tests—imac-2:~ testd csrutil status
System Integrity Protection status: disabled.
tests—imac-2:~ tests I

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.

Using with iODBC

Using the Driver with iODBC

Among known issues with iODBC driver manager is incorrect handling of the following ODBC
data types:
e SQL_ WCHAR

e SQL_WVARCHAR
e SQL_WLONGVARCHAR

For this reason, we recommend using the following data types instead:
e SQL CHAR

e SQL_VARCHAR
e SQL_LONGVARCHAR

If you have to work with the SQL_WCHAR, SQL_WVARCHAR, and SQL_WLONGVARCHAR
data types, we recommend that you use the unixODBC driver manager rather than iODBC.
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3.9 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

86

ODBC Driver for ASE

3.10

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

Usage Statistics

Usage Statistics

ODBC Driver for SAP Sybase Adaptive Server Enterprise can collect anonymous usage
statistics. This data helps us improve product quality, resolve issues faster, and better
understand how our products are used.

The collected data is anonymous and does not include personal information. The amount of
transmitted data is minimal and is used only for diagnostic and product improvement
purposes.

Collected Data

The driver collects the following data:

¢ Product name and version.

e Name of the process (application) using the driver.

e License information: license type, license number, and license status.
e Operating system name and version, number of processor cores.

e An anonymous user identifier.

The user identifier is an internal ID generated only for statistical purposes. It is not the

operating system user name and cannot be used to identify the actual user.
e An anonymous hardware identifier.

The hardware identifier is an internal ID generated only for statistical purposes. It does not
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contain any data that can identify specific hardware.

e Database server name and version.

e Names of connection parameters used to connect to the database server.

Only parameter names are collected. We do not collect parameter values such as database

name, user name, or password.

e Connection result: success, or a numeric error code if the connection fails.

Only the numeric error codes are collected. We do not collect full error messages, which

might contain sensitive data (for example, database or user names).

Default Settings

Usage statistics is enabled by default when you install the driver.

To disable usage statistics, follow the instructions for your operating system:

e Enable or Disable Usage Statistics on Windows

e Enable or Disable Usage Statistics on macOS

e Enable or Disable Usage Statistics on Linux

3.10.1 Enable or Disable on Windows

Enable or Disable Usage Statistics on Windows

Usage statistics is enabled by default when you install the driver. You can disable it in one of
the following ways:

¢ During installation: In the installation wizard or from the command line.

e After installation: By editing the Windows Registry.

Disable Usage Statistics in the Installation Wizard

To disable usage statistics in the installation wizard, clear the Improvement Program

checkbox on the last page of the wizard. The checkbox is selected by default.
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ﬁ_."?'.-! Setup - Devart ODBC Driver —

Completing the Devart ODBC Driver Setup
Wizard

Setup has finished installing Devart ODBC Driver on your
computer.

[ Improvement Program™

ODBC Driver

Hedg 8 improve our products and §ix B Tasber by sharing a Emiled s of
ancynies data, inchuding Tunclionalily wsage slatstics, dagnostic nfomation, and
pesTarmance data,

Disable Usage Statistics From the Command Line

When you install the driver from the command line, you can disable usage statistics by
adding the /NousAGESTATISTICS parameter to the command.

Silent and Very Silent Mode

To disable statistics during silent or very silent installation with the EXE installer, run one of
the following commands:

DevartODBCASE.exe /NOUSAGESTATISTICS /SILENT
DevartODBCASE.exe /NOUSAGESTATISTICS /VERYSILENT

Quiet Mode

To disable statistics during quiet installation with the MSl installer, run the following command
as an administrator:

msiexec /i DevartODBCASE.msi /g NOUSAGESTATISTICS=true

Change Usage Statistics Settings in the Windows Registry

To enable or disable usage statistics for an installed driver, edit the Windows Registry as
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follows:

1. Open the Registry Editor. To do this, press Win+R, type regedit in the Run dialog, and
press Enter.
2. Depending on your driver version, navigate to one of the following keys:

e 64-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI\Devart ODBC Driver for

SAP Sybase Adaptive Server Enterprise

e 32-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ODBC\ODBCINST.INI\Devart ODBC

Driver for SAP Sybase Adaptive Server Enterprise

3. Set the value of the usagestatistics parameter to False to disable statistics, or True to

enable statistics.

3.10.2 Enable or Disable on macOS

Enable or Disable Usage Statistics on macOS

Usage statistics is enabled by default when you install the driver. You can disable it in the
installation wizard or later using a console application.

Disable Usage Statistics in the Installation Wizard
To disable usage statistics in the installation wizard, on the Registration page, clear the

Improvement Program checkbox.
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[ ] « Install Devart ODBC Driver for Salesforce ]
Registration

License information

Please enter the path to the file containing the activation key
Read Me received when purchasing the product. If you have no
activation key, select Trial Version.

Introduction

License
#® Registration Trial
Destination Select O Activation Key
Installation Type u1W7ICODSBNGAEOFabNziucK.JzVXGPYrkRYSHBT7Iv+thoF0387TUwn

RhweaiSanY siKzNH2irv1 LEAXNWT3rNhlAZ+L0/+1+i75BIGARSa0c=
Load Activation Key ...

Improvement Program®*

*Help us improve our products and fix issues faster by sharing a limited set of
anonymous data, including functionality usage statistics, diagnostic information, and
performance data.

Go Back Continue

Enable or Disable Usage Statistics in a Console Application

To enable or disable usage statistics using a console application:
1. In the console, go to the folder where the driver was installed. The default installation path

for the driver is /Library/0DBC/Devart/ASE.

2. Run the activation command with superuser privileges using the -u option. Set the value to

false to disable usage statistics or true to enable it.
e To disable usage statistics: sudo ./aseodbcactivator -u false

e To enable usage statistics: sudo ./aseodbcactivator -u true

3.10.3 Enable or Disable on Linux

Enable or Disable Usage Statistics on Linux

Usage statistics is enabled by default when you install the driver. The graphical installer
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doesn't provide an option to disable usage statistics. You can disable statistics during
package installation or after installation using a console application.

Disable Usage Statistics During Package Installation

To disable usage statistics when installing a DEB or RPM package, set the
NOUSAGESTATISTICS environment variable to true.

DEB Package
To disable usage statistics when installing a DEB package, run the following command:

sudo NOUSAGESTATISTICS=true dpkg -i devartodbcase.deb
RPM Package

To disable usage statistics when installing an RPM package, run the following command:

sudo NOUSAGESTATISTICS=true rpm -ivh devartodbcase.rpm

Enable or Disable Usage Statistics After Installation

To enable or disable usage statistics for an installed driver, use a console application.

1. In the console, go to the folder where the driver was installed. The default installation path
is:
e DEB package: /usr/share/devart/odbcase

e RPM package: /usr/local/devart/odbcase

2. Run the activation command with superuser privileges using the -u option. Set the value to

false to disable usage statistics or true to enable it.

e To disable usage statistics:
sudo ./aseodbcactivator -u false -1 /etc
®* To enable usage statistics:

sudo ./aseodbcactivator -u true -i /etc

3.11 Supported Data Types

Data Type Mapping

The Devart ODBC Driver for ASE supports all ASE data types.
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The following table describes how the ASE data types are mapped to the ODBC data types.

ASE Data Types ODBC Data Types
tinyint

tinyint identity SQL_TINYINT
smallint

smallint identity SQL_SMALLINT
usmallint

int

int identity SQL_INTEGER
uint

bigint

bigint identity SQL_BIGINT
ubigint

decimal

money

smallmoney SQL_DECIMAL
decimal() identity

numeric

numeric() identity SQL_NUMERIC

char

SQL CHAR
nchar -

varchar

SQL_VARCHAR
nvarchar

syshame

. SQL WVARCHAR
univarchar -

text
SQL LONGVARCHAR
ntext -

binary

, SQL_BINARY
timestamp
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datetimeoffset
datetime2

. SQL TYPE TIMESTAMP
datetime - -

smalldatetime

unichar SQL WCHAR

unitext SQL WLONGVARCHAR
varbinary SQL VARBINARY

time SQL TYPE TIME

xml SQL XML

sql variant SQL VARIANT
uniqueidentifier SQL GUID

bit SQL BIT

float SQL DOUBLE

image SQL LONGVARBINARY
real SQL REAL

date SQL TYPE DATE

3.12 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for SAP Sybase Adaptive Server Enterprise supports all deprecated functions

for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle .\/ ISO 92 connection,
statement, or

descriptor handle.
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SQLConnect v ISO 92
SQLDriverConnect v ODBC
SQLAllocEnv v Deprecated
SQLAllocConnect v Deprecated

Connects to a
specific driver by
data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
environment handle
allocated from driver.
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver

and Data Source

Function Name Support Standard
SQLDataSources v ISO 92
SQLDrivers v ODBC

Purpose
Returns the list of

available data
sources, handled by

the Driver Manager

Returns the list of
installed drivers and

their attributes,
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SQLGetInfo

SQLGetFunctions

SQLGetTypelnfo

ISO 92

ISO 92

ISO 92

handles by Driver
Manager

Returns information
about a specific
driver and data
source.

Returns the functions
supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr

SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvAttr

Support

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ISO 92

ISO 92

Purpose
Sets a connection

attribute.

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of
a connection option
Sets an environment

attribute.

Returns the value of

an environment
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SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

ISO 92

ISO 92

Deprecated

Deprecated

attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e

SQLSetCursorNam

e

SQLSetScrollOption

S

Standard

Deprecated

ISO 92

ODBC

ISO 92

ISO 92

ODBC

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later
execution.
Assigns storage for
a parameterinan
SQL statement.
Returns the cursor
name associated
with a statement
handle.

Specifies a cursor
name.

Sets options that
control cursor

behavior.
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ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute ./ ISO 92
statement.

Executes a
SQLExecDirect v ISO 92
statement

Returns the text of an

SQL statement as
SQLNativeSq| v OoDBC

translated by the

driver.

Returns the
_ description for a
SQLDescribeParam v ODBC _
specific parameter

in a statement.

Returns the number
SQLNumParams v ISO 92 of parameters ina

statement.

Used in conjunction

with SQLPutData to

supply parameter
SQLParamData v ISO 92 PPYP

data at execution

time. (Useful for long

data values.)

Sends part or all of a

data value for a
SQLPutData v ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
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about Results

Function Name Support

SQLRowCount

SQLNumResultCols

SQLDescribeCol

SQLColAttribute

SQLColAttributes

SQLFetch

SQLFetchScroll

SQLExtendedFetch

SQLSetPos

Standard

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

ISO 92

ISO 92

Deprecated

ODBC

Purpose
Returns the number

of rows affected by
aninsert, update, or
delete request.
Returns the number
of columns in the
result set.
Describes a column
in the result set.
Describes attributes
of a columnin the
result set.
Describes attributes
of a column in the
result set.

Returns multiple
result rows.

Returns scrollable
result rows.

Returns scrollable

result rows.

Positions a cursor
within a fetched
block of data and
enables an

application to refresh
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SQLBulkOperations v ODBC

data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name Support Standard
SQLError v Deprecated
SQLGetDiagField v ISO 92
SQLGetDiagRec v ISO 92

Purpose
Returns additional

error or status

information

Returns additional
diagnostic
information (a single
field of the
diagnostic data

structure).

Returns additional
diagnostic
information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About
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Database Objects (Catalog Functions)

Function Name Support Standard Purpose
Returns a list of

. columns and
SQLColumnPrivileg

es

v, ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v, X/Open column names in
specified tables.
Returns a list of
column names that

SQLForeignKeys v, ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of

SQLPrimaryKeys v, ODBC column names that
make up the primary
key for a table.
Returns the list of
input and output

parameters, as well
SQLProcedureColu

mns

' ODBC as the columns that
constitute the result
set for the specified

procedures.
Returns the list of

SQLProcedures v ODBC procedure names

stored in a specific
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SQLSpecialColumn

S

SQLStatistics

SQLTablePrivileges

SQLTables

X/Open

ISO 92

ODBC

X/Open

data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
that are
automatically
updated when any
value in the row is
updated by a
transaction.
Returns statistics
about a single table
and the list of
indexes associated
with the table.
Returns a list of
tables and the
privileges
associated with
each table.

Returns the list of
table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions
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Function Name Support Standard Purpose
Commits or rolls
SQLTransact v Deprecated
back a transaction
Commits or rolls
SQLEndTran v ISO 92

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees alll
resources
associated with the

statement handle.

Closes a cursor that

SQLCloseCursor v ISO 92 has been opened on
a statement handle.
Cancels an SQL
SQLCancel v ISO 92
statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
. Closes the
SQLDisconnect v ISO 92
connection.
Releases an

environment,
SQLFreeHandle v ISO 92 y
connection,

statement, or
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descriptor handle.

Releases connection
SQLFreeConnect v Deprecated

handle.

Releases an

SQLFreeEnv v Deprecated
environment handle.

4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for SAP Sybase Adaptive Server Enterprise
with ODBC-compliant tools.

e DBeaver
e DBxtra

¢ |nformatica PowerCenter

¢ Microsoft Access

e Microsoft Excel

e Microsoft Visual Studio

e OpenOffice and LibreOffice

¢ Oracle Database Link

* PHP
e Power BI

* Python

e QlikView

e SQL Server Management Studio

e SSIS

e Tableau

41 Usingin DBeaver

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

104

ODBC Driver for ASE

411

This section describes how to connect DBeaver to ASE using Devart ODBC Driver for ASE.
e Connect DBeaver Community to ASE through ODBC

e Connect DBeaver Enterprise to ASE through ODBC

Connect DBeaver Community to SAP ASE through ODBC

DBeaver Community and DBeaver Enterprise let users connect to ASE via ODBC, enabling
SQL-based querying, reporting, and data management.

If you need basic ODBC connectivity to ASE and are comfortable with manual configuration
using a generic ODBC Connection, choose DBeaver Community—a free, open-source
database management tool.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise. For more information on
connecting to ASE data from DBeaver Enterprise, see Connect DBeaver Enterprise to ASE
through ODBC.

Initial configuration

1. Download jdbc-odbc-bridge-jre7.jar and x64/3dbcodbc.d11 from Github.

2. Download the Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package

from the Microsoft website.

The built-in legacy ODBC driver was removed in DBeaver Community Edition 23.1. If you're
using an earlier version of DBeaver Community, skip steps 1 and 2.

3. Configure an ODBC data source. For more information, see Windows DSN Configuration.

4. On the Advanced Settings tab of the DSN configuration window, select Ansi from the
String Types.

This option is required for the proper display of the SQL_WVARCAHAR data type in DBeaver.
It also ensures that all string types will be returned as SQL_CHAR, SQL_VARCHAR, and

SQL_LONGVARCHAR.
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Devart ODEC Driver Configuration

General Advanced Settings Tradng License About

Metadata
B Empty Strings as NULL B allow NULL Strings

[ ] Return Foreign Keys {may significantly degrade performance)

Cache Metadata 1Day o
Connection

Connection Timeout &0 [CJuTC Dates
Query Timeout &0 [} indude Deleted

Use Local Regional Settings when converting to string

[ Mumbers [ Dates and Times
Compatibility

ODEC Behavior Default b4

String Types | Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LON( ~

Test Connection . Cancel

Connect to ASE

1. In DBeaver, select Database > Driver Manager.

2. Click New.

105
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=% Driver Manager

Type part of database/driver name to filter

Mame

W sOlite
1 Altibase
@ Apache Calcite Avatica
& Apache Ignite
# Apache Kylin
> B3 AWS
s S Azure
& Arure Databricks
Q Babelfish via TDS (beta)
[| Cache
= (Cassandra
ClickHouse
ClickHouse (Legacy)
A% Clondhern:

Generic provider

3. Configure the following properties for a new driver:

¢ |n the Driver Name field, enter ODBC.
¢ |In the Class Name field, enter sun.jdbc.odbc.JdbcOdbcDriver

¢ In the URL Template field, select jdbc:odbc:{database}.

Copy

Edit ...
Delete
Un-delete

T - User defined

& - Unavailable

Close
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@ Create new driver

Settings | Libraries | Default properties | Advanced parameters

Driver Name:  ODBC Driver Type: | = Generic v

Class Mame: sun,jdbc.odbe)dbcQdbeDriver

URL Template: jdbciodbo{database}
Default Port:

Default Database:

Default User:

[[JErmbedded [] Propagate driver properties [_] No authentication [_JiAllow Empty Password:
[[] Use legacy JDBC instantiation [ Thread safe driver

Description

1D 55052241-1D12-5734-4177-5C2F49673070

Description:

Reset to Defaults Cancel

4. On the Libraries tab, click Add File.

5. Select the jdbc-odbc-bridge-jre7.jar, then click OK. After that, select 3dbcodbc.d11, then
click OK.
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(@) Create new driver

O X
Settings | Libraries | Default properties | Advanced parameters
s Ci\Users) \Downloads\download_files\jdbc-odbc-bridge-jre? jar hdd File
En C\Usersy \Downloadshdownload_files\JdbcOdbe.dll s
Add Folder
Add Artifact
Edit ...
Delete
Download/Update
Information
Classpath
Driver class: ~ | Find Class Export
Reset to Defaults oK

Cancel
[

6. Once a new ODBC driver appears on the list, click Close.
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=% Driver Manager O >

Type part of database/driver name to filter

Mame # Copy

MDB Cluster

® Neodj Edit ..

M Metezza Delete
MucDB -

c8 OceanBase Un-delete

O Ocient

E ODBC T - User defined

= ODBC - Legacy B - Unavailable

E] Omnisci (formerly MapD)
:.) Open Distro Elasticsearch
8. OpenEdge

h_-"j OpenSearch

E Cracle

MirientE

Close [:?

7. Select Database > New Database Connection.
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(g) DBeaver 24.3.5
File Edit Mavigate Search 50LEditor Database Window Help
¢ - JsaL ~

f® Database Navigator [ Projects

e—1

Mew Database Connection

Mew Connection from JDBC URL

0w

Driver Manager

Enter a part of object name here

Disconnect All

Open Dashboard

% B

Tools
Context tools
& Tasks

8. Select the ODBC driver, then click Next.

= O x
Ctrl+Shift+ M | s
=5
Ctrl+ Alt+5Shift+ B
>
Alt+"
* T|en
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| ) Connect to a database O >

Select your database

Create new database connection. Find your database driver in the list below.

Type part of database/driver name to filter ¥ | Sortby: O Title €@ Score
|
2 Al ¥y d ™ |
Ty crn® ORACLE
& Popular MariaDB MySQl
EN SOL
D2 for LUW MaraDB MySOL Oracle
B NoSQL
EN Analytical
EN Timeseries :‘;_;.‘23 AlTisase
N Embedded ﬁ‘ﬁﬂkﬁ,e
rver
“F Hadoop / BigData ! ~
PostgreS0L SOL Server S0Line Alibaze Apache Calcite
Auatica
-
Test Connection ... < Back Mesxt = Finish Cancel

9. In the Database/Schema field, specify the name of your DSN.
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Generic JDBC Connection Settings
ODBC connection settings

Main | Driver properties | 55H

General
Connect by: © Host (JURL

Jjdbc:odbo:DEEAVER_DATASOURCE
Database/Schema: DBEAVER_DATASOURCE

-+ Metwork configurations...

Authentication (Database Mative)

Username:

Password: B Save password

(1) Connection variables information

Driver name: ODBC

Test Connection ... < Back

Connection details (name, type, ... ]

Driver Settings

m
-

10. Optional: Select Test Connection to verify the connection settings.

E Connection test

Driver: JDBC-ODBC Eridge (DevartODBC
(03.04.0200)

11. Click Finish.

The database appears on the left pane.

=

.dil) 2.0001

Details ==

12. To view the data stored in a table, expand the database structure and click the needed

table.
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(%) DBeaver 24.3.5 - Account = a X
Eile Edit Mavigate Search 50OLEditor Database Window Help
¢ v| W & | [OsaL «:[% Commit [2FRolback T v @ Auto |4 v DBEAVER DATASOURCE ~ [E <N/A> v @y~ b »: Q ~
Q iE|®
f® Database Mavigator 3 [ Projects = O FBAccount X S5 DBEAVER_DATASOURCE B8 Solution = 0
= FF Properties | ) Data ﬁg-n ER Diagram|
Enter a part of object name here T - -
« =, DBEAVER DATASOURCE EEAC(UU”tlzs- nression to filter results (use Ctri+Space » |v e d T = =
~ [ Tables | [z o) . V‘AZV|A-!NHI! V|A-ZV|A-ZV|AZV|AZV|AZV| [ Value X i |
o
’ ;i“e"ti"a’e"me'““’” fH 118 0012400 [1  [MULL] Kate West (Sample) Custorr [MULL Kings P [NULL B R |
? ccoun —"110 | 001240 [1 [MULL] Kate West (Sample) Custor [MNULL 9 Tagor Singape Smgap: 00108000020EKXLA & | &
5 9 AccountChangebvent b1 E AD
s M AccountCleanlnfo — 120 oo2400 [ ] IULL] Kate West (Sample) Custor [MULL 312 Cor Austin TX gg
5 FM AccountContactRole [_3' 121 oo2400 [ ] [MULL] Kate West (Sample) Custorr [MULL 5255, L Burling NC ®
5 [ AccountContactRoleChangeEvent 122 oo2400 [ ] IULL] Kate West (Sample) Custorr [ULL 2 Place Paris IULL i
5 M9 AccountFeed = 123 0012400 [ ] IULL] Kate West (Sample) Custorr [MULL 1301 He Lawren KS N
s B9 AccountHistory 2 124 | 001240 []  [MULL] KateWest (Sample) Custorr [MULL 2334 N. Chicag: IL B
5 B AccountPartner E 125 | 0012400 []  [MULL] Kate West (Sample) Custorr [MULL 620 SW Portlan OR
» B8 AccountShare 126 0012400 [ ] IULL] Kate West (Sample)  Custor [MULL 838 N E Tucson AZ
» B8 ActionLinkGroupTemplate 127 0012400 [ ] [MULL] Kate West (Sample) Custorr [MULL 1307 Av New Yc NY
» A ActionLinkTemnplate 128 oo2400 [ ] IULLT Kate West (Sample) IULL] [MULL. The Lar San Fra CA
> FA ActiveFeaturelicenseMetric 129 | 0011p00 [ ] JULL] Kate West (Sample) [NULL] [NULL) [NULL] [MULL] [NULL
» A ActivePermSetLicenseMetric 120 nninant 11 1 Kate Weet (Samnlel 1 1
3 B3 ActiveProfileMetric int
5 E2 ActivityFieldHistory @ Refresh v | () Save v Cancel = S i@ = il¢ € » U X Exportdata ~ | €8
5 A ActivityHistory - -
200 Z 200+ : () 200 row(s) fetched - 0.653s (0.061s fetch), on 2025-02-19 at 17:20:16 - 5 waming(s) l‘_‘\
S, DBEAVER_DATASOURCE » FF Account Table: Announcement | EET | en
1. Select SQL Editor > New SQL script.
(&) DBeaver 24,35 - Solution - ] X
File Edit Mavigate Search 50L Editor Database Window Help
¥ -‘ Ve q| [Jsc [J OpensaLscript F2
Last edited SOL script Ctrl+Enter
DBEAVER_DATASOURCE ~ [ E ’ Q 124 | @
[ New SOL script Ctrl+]
= =+ =
£= Database Navigator X [ Open 50L console Cirl+Alt+Enter =
. Panels >
Enter a part of object name here ST~ o
L/ - - J
5 B8 Seclution Rayoul 2 |
s+ [ SolutionFeed Context 3 ¥ | Az Solutiont [y x| = x|
5 B9 SeclutionHiste -
FA SelutionStat ] Aut cti ith igat 0000000 B Eg =
¥ clutionStatus uto-sync connection with navigator 2 5012400000 a | =
» E5 Stamp Open separate connection > 00000003 OcvwCzAA| S5
» FH StampAssignment . LL
» B StaticResource - i il I [] @
» B3 StreamingChannel 3 30124000000cvD3AAI [ 00000003 5]
» B3 StreamingChannelShare ] 30124000000cvDAAAI [] 00000006 E
s+ [ TabDefinition ’f—, 7 50124000000cvD5AAI [] 00000007
> E TabledVerify_c E E
» o TabledVerify__ChangeEvent I ] @ Refresh ~ @ () Save = Cancel : =5 Z4 If ==
» 3 TableauHostMapping
r . -
» [ TableauHostMappingShare HE € > M b d, Exportdata ~ g 200 X 0

« A Tack

=% » B2 Solution  Table: TaskPriority

10 row(s) fetched - 0.241s (0.003s fetch), on 2025-02-24 at 16:15:48

|EI-_—I'|en
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2. Enter your query.

() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search 50l Editor Database Window Help
L3 v| ¢ ¢ [Jsa ~i[} = | T ~ @ | Aute |40 v DBEAVERDATASOURCE ~+ [H]<N/A> + 3~ & » Q ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
= & E [ 3 SELECT SolutionName, SolutionNote FROM Solution,‘|
Enter a part of object name here ¥ - ».
> B8 Site o]
> B8 SiteDetail -
» A SiteFeed -
» P SiteHistory
» A SitelframeWWhiteListUrl
> FH SiteRedirectMapping
» E2 Solution
5 A SolutionFeed
» F2 SelutionHistory
» A SolutionStatus
» B8 Stamp
» FH StampAssignment
» A StaticResource e ]
> FH StreamingChannel
» F2 StreamingChannelShare
B
» F2 TabDefinition I
» B8 TabledVerify_c I}
> FX TabledVerify_ ChangeEvent =
3 A TableauHostMapping HE
EET | en | Writable Smart Insert 1.8
3. Select SQL Editor > Execute SQL query.
The query results are displayed in the main window.
() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search SOLEditor Database Window Help
& v| oW [Jsa - t 2 T @ Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> ~ iy~ &b viQ ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
=+ 8 » SELECT SolutionName, SolutionNote FROM Solution;|
Enter a part of object name here ¥ - ».
> B8 Site 3
> B8 SiteDetail m
» A SiteFeed
s 3 SiteHistory T SELECT SolutionMame, Solu | § 5 £nt to filt t t b v | 2T~ - -
» B9 SitelframeWhiteListUrl = | 22 SolutionName w | Az SolutionNote -  Value X = g
SiteRedirectM had 2
z ; Sloleu‘tleo:e wdld, isij GC1020 Portable Generator Switch Mal‘fud If the generator switch is not working, rerr [ U =] =0 “3_’0
. & Generator assembly instructions unclear  The Maintenance Manuals for the GC1020 GC1020 Portable | & | &
5 A SolutionFeed g
s E3 SolutionHistory - 3 Maintenance guidelines for generator unc The Maintenance Manuals for the GC1060 -
» [ SolutionStatus E 4 Selecting the Right Generator for Your Nee GenWatt offers a wide range of electric ge @)
» [ Stamp 5 GC3000 Series Propane Generator Ignition The GC3000 series propane generators nee A
> FE StampAssignment & Starting generator after electrical failure  After an electical failure, the generator has N
> FF StaticResource 7 Electrical wiring installation for GC5060  The red wiring from the top electronic par iz
» F2 StreamingChannel s GenWatt SLA Commitments GenWatt offers four different SLAs with dil =,
» F2 StreamingChannelShare é 9 Electronic panel fitting loose On the GC3020, the electronic panel is knc
» FH TabDefinition | g 10 GenWatt Installation Services GenWatt Corporation has a full-service su|
» F3 TabledVerify_c -
> B8 TabledVerify_ChangeEvent @ Refresh e v SR m =il < oo : 1 Exportdata ~ 3
> FA TableauHostMapping
200 XY o10: 10 row(s) fetched - 0.378<, on 2025-02-19 at 18:34:18 [ Ja}
EET | en | Writable Smart Insert 1.8

© 2025 Devart

Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 115

41.2

Connect DBeaver Enterprise to SAP ASE through ODBC

DBeaver Enterprise and DBeaver Community let users connect to ASE via ODBC, enabling
SQL-based querying, reporting, and data management.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise.

If you need basic ODBC connectivity to ASE and are comfortable with manual configuration
using a generic ODBC connection, choose DBeaver Community—a free, open-source
database management tool. For more information on connecting to ASE data from DBeaver
Community, see Connect DBeaver Community to ASE through ODBC.

Connect to ASE

To connect to the ASE database from DBeaver Enterprise:
1. Select Database > New Database Connection.

2. Select the ODBC driver and click Next.
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) Connect to a database O x
Select your database
Create new database connection. Find your database driver in the list below.
Type part of database/driver name to filter & | Sortby: (O Title @ Score
|
£ Al ST §
E P la ‘:::E-F ‘: [y 1\-\: I
i MariaDB MySQL
Em saL )
Db2 for LUW MariaDB MongoDB MySOL
N NoSOL
£ Analytical
0 Timeseries St 4 b ?&Z’
8 Embedded ORACLE op-o oL G
4 h SOL Server
= Oracle Postgres0L Redshift Snowflake SOL Server

Test Connection ... < Back Finish Cancel

3. In the Database Source field, specify the name of your DSN.
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@) Connect to a database O *
ODBC Connection Settings 0 D
ODEC connecticn settings BC
Main | Driver pruperties| 55H| = Metwork configurations...
Connection
Type: @ Data Source () Manual
Data Source: ‘ DEEAVER_DATASOURCE |

(i) Open ODBC Administrator tool

Authentication

Authentication: Database Mative -

Lzername:

Password: B Save password @
(E} Connection variables information Connection details (name, type, ... )
Driver name: ODBC Driver Settings

Test Connection ... < Back MNext = Cancel

4. Optional: Select Test Connection to verify the connection settings.

E Connection test O X

@ Connected (6527 ma)

Serven N

Driverr DBeaver JDBC-ODBC Bridge (DevartODBC" o «.dlf)
1.0.71 (03.04.0200)

Details ==

5. Click Finish.
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The database appears on the left pane.

6. To view the data stored in a table, expand the database structure and click the needed

table.

@ DBeaver Enterprise 24.3.0 - Account

£0) ~ ' [J] DBEAVER DATASOURCE ~ [E] < N/A >

File Edit Mavigate S5earch 50l Editor Database Window Help
€| v v Osa - T e A
f® Database Navigator X [ Projects = O B Account X [FB AccountChangeEvent
. P
=+ 3 F2 Properties | £} Data D-Eﬁ ER Diagram
Enter a part of object name here h

[m]

X

o -m-avia-

Q B|@

= 8

Eﬂ DBEAVER_DATASOURCE [ Tables ~ [T Account

L)
« [ DBEAVER_DATASOURCE £R Account |23 B AR
v [ Tables I = @ | Az | Az BillingStreet - ‘ a2 BillingCity + ‘ a2 BillingState . [ value x| = s |
» FH AcceptedEventRelation % : w-B Eﬂ 2 hd
» B Account " =
> E AccountChangeEvent _ 2 312 Constitution PlaceTAustin, TX 78767TUS/ Austin TX UK w
5 M9 AccountCleaninfo é 3 888 N Euclié THallis Center, Room 501 TTucse Tuc.son AT gg
» 2 AccountContactRole T4 2 Place Jussieu Paris ) ()]
5> F AccountContactRoleChangeEvent £ 3 The Landmark @ One Market San Francisco CA =
©
5 F AccountFeed S 6 2334 N, Michigan Avenue, Suite 1300TChicac Chicago IL .
> B8 AccountHistory Y 7 9 Tagore LanellSingapore, Singapore 7874721 Singapore Singapore iz
» A AccountPartner 8 345 Shoreline ParkTMountain View, CA 8404 Mountain View CA =y
» (A AccountShare 9 1301 Avenue of the Americas TMNew York, NY Mew York NY
5 FH ActionLinkGroupTemplate 10 1301 Hoch Drive Lawrence KS
» B2 ActionlinkTemplate 1 525 5. Lexington Ave Burlington NC
» BB ActiveFeaturelicenseMetric 12 620 SW 5th Avenue Suite 400TPortland, Oreg Portland OR
. - . -
> 3 ActivePermSetLicenseMetric s IB Kings Park, 17th Avenue, Team Valley Tradin [
» [ ActiveProfileMetric ‘15
> FH ActivityFieldHistory £ —
> FH ActivityHistory
» F2 AdditionalMumber @ Refresh + ° - Wil < > : 1 Exportdata v 4%
s P Address 5
200 RARER - 13 row(s) fetched - 0.209s (0.057s fetch), on 2025-02-20 at 20:3%:07 '2
EET | en

Query ASE data

1. Select SQL Editor > New SQL script.
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() DBeaver Enterprise 24.3.0 - Solution - O X
File Edit MNavigate Search SOLEditor Database Window Help
¢ ‘ 9 # % | Osc O OpensaLscript ER
- . i
: m DBEAVER DATASOURCE 15 Last edited SQL script Q M | @
T New SQL script Ctrl+]
& Database Navigator = Open 5L console = 0
Enter a part of object name here — B
> [0 SlaProcess Layout > DATASQURCE [ Tables = [T Solution
v E5 Solution Select active schema erresh |[v| BT v dm~ =~
> v Celumns o o ) '
> [ Keys £+ connection Trom navigator v | az Solutionh ¥ | Az Solutionh v | e |
> I Foreign Keys Auto-sync connection with navigater 00000010 GenWatt Install = &
[
>l I:;exes To e 5 00000001 GC1020 Portabl | &
> ferences = s | VIV I LELW Ll 00000002 Generator asser 29
» B SolutionFeed = ®
» FH SelutionHistory - T e
R h = : Save w [®] Cancel : = =3 = —
» BB SolutionStatus | E @ Refres O b Can ISy 24 CH S =
> EB SPSemiAttributes o i< < > Ol M it bpordaa vigk 20 X 10 i
» 8 Stamp 9 -
) 10 row(s) fetched - 0.264s (0.016s fetch), on 2025-02-24 at 16:40:38 =
- I I
2. Enter your query.
(@) DBeaver Enterprise 24,3.0 - <DBEAVER_DATASOURCE> Script = a X

File Edit Mavigate Search 50L Editor Database Window Help
¢ v| % & N | [Tsat =:i[} Commit [ Rollback T~ & Auto o EDBEAVER_DATASOURCE - <NA> v~~~ ~iQ ~
Q i®|l@®

= Database Navigator ¢ [ Projects = B [ Account A AccountChangeEvent Q *<DBEAVER_DATASOURCE> Script ¢ =
§

= & ] SELECT SolutionName, SolutionNote FROM Snlutinn,‘|

1Y) Iy (G sepung === | oupy [T O

Enter a part of object name here N
w DBEAVER_DATASOURCE
v [ Tables I
> FH AcceptedEventRelation
» A Account
» B2 AccountChangeEvent
» 2 AccountCleaninfo
5 A AccountContactRole
» 2 AccountContactRoleChangeEvent
» FA AccountFeed
» FH AccountHistory
» B8 AccountPartner
» B8 AccountShare
> F2 ActionLinkGroupTemplate
» F2 ActionLinkTemplate
» B8 ActiveFeaturelicenseMetric n
» A ActivePermSetLicenseMetric
» A ActiveProfileMetric B
> BB ActivityFieldHistory
> FH ActivityHistory )
5 [ AdditionalMumber [
o= v
5 P Address 0= < . 0‘)

| EI:T| en | Writable | Smart Insert 1:49:48 Sel

M@ lmE >

3. Select SQL Editor > Execute SQL query.

The query results are displayed in the main window.
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@ DBeaver Enterprise 24.3.0 - <DBEAVER_DATASOURCE> Script = a x
Eile Edit Mavigate Search 50LEditor Database Window Help
L3 v| & W | [Jsa ~ T v @i Auto |4D v [FIDBEAVERDATASOURCE ~ El<N/A> v @~ @l v & v Q ~
Q B|@
f® Database Mavig.. » [ Projects = B FH Account 8 AccountChangeEvent [, *<DBEAVER_DATASOURCE= Script % = 8
= & | 3 SELECT SolutionName, SolutionNote FROM Solution; D
Enter a part of object name here T~ =
=
~ [ DBEAVER_DATASOURCE =
v [ Tables | B solution1
> FH AcceptedEventRelation T SELECT SolutionName, Solt | 5 2 P lw| B T v =~
» [ Account ——
5 F9 AccountChangeEvent E = | a7 SelutionName | a7 SelutionNote ¥ | T Value X = g
> 8 AccountCleaninfo M O | GenWatt Corporation has a full-service suppc | U= 0 ":,_?
> 8 AccountContactRole o 2 GC1020 Portable Generator Switch Malfunctior If the generator switch is not working, remowe Geniatt Instal =
> F3 AccountContactRoleChangeEvent 273 Generator assembly instructions unclear The Maintenance Manuals for the GC1020 are =
> B Ac(ountFe.ed [?;' 4 Maintenance guidelines for generator unclear  The Maintenance Manuals for the GC1060 are ®
> B icmuntslstor)r + 5§ Selecting the Right Generator for Your MNeeds  GenWatt offers a wide range of electric gener i
’ g Accounts:rtner é 6 GC3000 Series Propane Generator Ignition The GC3000 series propane generators need t i
? c(.nun. are 27 Starting generator after electrical failure After an electical failure, the generator has to i)
» B3 ActionLinkGroupTemplate . L . ™ + =]
Lo 8 Electrical wiring installation for GC5060 The red wiring from the top electronic panel ¢ =
» FE ActionLinkTemplate = . . ; d
5 FF ActiveFeatureLicenseMetric s 9 Electronic panel fitting loose On the GC3020, the electronic panel is known
5 O ActivePermSetLicenseMetric 3:: 10 GenWatt SLA Commitments GenWatt offers four different SLAs with differ
» B8 ActiveProfileMetric il [—
» FH ActivityFieldHistory @ Ref 3 ] :
resh - : - T R T, Exportdata ~ :
> B Ackhiybitory B . W= > 2  Bxp X
200 x 10 : =10 row(s) fetched - 0.35%s, on 2025-02-20 at 20:46:03 l‘_\
EET | en | Writable Smart Insert 1:45:48 Sel

4.2 Using in DBxtra

Troubleshooting ASE ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to ASE in DBxtra.

Due to incompatibilities between DBxtra and ASE, leaving the sqL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 Or ANSI sqQL/2ee3 for DBxtra version 11.0.1 or newer, and to ANST
sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

Connection timeout | 15| 5| sqL dislect| | MS Access 2000/... |w |

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel

4.3 Using in Informatica PowerCenter

You can access ASE data from Informatica PowerCenter on Windows and Linux.

e Connect Informatica PowerCenter to ASE on Windows

e Connect Informatica PowerCenter to ASE on Linux

431 Connectto Informatica PowerCenter on Windows

You can connect Informatica PowerCenter to ASE through an ODBC driver on Windows to
unify and manage data across these systems.
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Prerequisites

e Configure the Informatica services.
¢ |nstall the PowerCenter Client tools.
¢ Create a repository folder in PowerCenter Repository Manager.

e |nstall Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise. For instructions,
see Installation.

e Configure a data source name (DSN). For instructions, see Windows DSN Configuration.

Add a data source in Informatica PowerCenter

Before you proceed, make sure PowerCenter Designer isn't running.

1-.Open.the.c:\Informatica\10.4.1\clients\PowerCenterClient\client\bin\powrmart.ini-file
in a text editor.

2. Inthe [obBCDLL] section, add Adaptive Server Enterprise=PMODBC.DLL, then save the
changes.

3. Open PowerCenter Designer.

4. Double-click the repository name (in this example, PCRS), enter your Informatica

credentials, then click Connect.
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0 Informatica PowerCenter Designer - [Start Page]

O X
0 Repository Edit View Tools Versioning Windows Help = =] 3
e R = S =Y =5 AL
(RJ(D]WEN] | GAEAFWRPED " ro @pakLEE @t LY [[EHAUsRpRBEEeEE
=l
& Repositories .
S B [P G Informatica | PowerCenter 10
Getting Started Resource Center
Mew Features and Enhancements Informatica.com
Product Overview Informatica Netwark
Connect to Repository x
Connect to Repository
Repositary: PCRS Cancel
Username: | USERNAME ‘ Help
Password | ] ‘ 2 Incements
’ ’ =5 More =3
] ) - Frirees B predictive analytics,
Security Domain: Mative = g, and integrated health
Homains.
Sign Up now to start using Operational Insights.
Copyright ® 1993-2020 Informstica LLC. All Rights Reserved
x|
|
Ill 4 I PI NI\ Save J{ Feich Log }\ Generate }, Validate J, Debugger )\Session Log }, Notifications ‘I < >
Ready I | V.

5. Double-click the repository folder (in this example, ODBC connections), then select
Sources > Import from Database.
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o Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] ] o
5‘9 Repository  Edit View Tools Layout Versioning  Sources  Window Help - & %
.= Import frem File...
0 o 0 @ &3 } Import from Cobol File..
==l w1 Import XML Definition...
& Repositories
B & PCRS o1l ~
e B Import From PeopleSoft ...
[ Business Components
- [ Sources ‘Web Service Provider L4
B Targets Import from Powerbxchange...
2 Cubes Import From Salesforce
) D\meﬂsions. Import From AmazonRSCloudAdapter
~ [ Transformations Import From Amazen53Plugin
B Mapplets i
) Mappings Import from Informatica Cloud...
- [f3 User-Defined Functions Create PowerExchange for BigQuery Source...
Create PowerExchange For Snowflake Source...
Create PowerExchange for Microsoft Dynamics 365 for Sales Source...
Create PowerExchange for Google Cloud Spanner Source...
Create PowerExchange for Google Analytics Source...
Create AzureDWv3 Source...
Create PowerExchange for Google Cloud Storage Source..,
Create PowerExchange For PostgreSQOL Source..,
Create PowerExchange for Kafka Source...
Create MongoDB Source...
Create SAPTableReader Source...
=4 Create...
v
< l_.g" Compare... 3
=
|
| ‘ | [\Save AFetch Log )\Generate ,\Valldate }\Debugger l,\Sasslorl Log )\ Matifications / H < >
NUM

Import from a given database

The Import Tables dialog opens.

. From the ODBC data source menu, select the needed DSN.

. Under Show owners, select All.

6
7. In the Username and Password fields, enter your ASE credentials.
8
]

. Click Connect.
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Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ ...

|Jse Kerberos Authentication Cancel
Username: | USERNAME | Help
Owner name: <ALL=
PaSSI.ﬂ,Iﬂrd: | ------------| |
Select tables

Show owners:

Default

Search for tables named:

I:I Search

Select all

Select naone

10.In the Select tables section, expand the tree and select the tables you want to import.

11.Click OK.
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Import Tables

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ |...

Cancel
|Jse Kerberos Authentication
Help
Username: | USERNAME | Z
Owrer name: <ALL > ==
Easswurd: | (121221173 7%] | F'.E—t_:ﬂr‘lﬂECt
Select tables
=-0 -iBLES * | Show owners:
----- 1] AcceptedEventRelation
----- Biiil Account — =z
""" EEE AccountContactRelation Search for tables named:
----- I AccountContactRole emch
----- fif] AccountFeed I:I
g1 Accounttistory |
----- gia) AccountPartner
----- if] AccountShare
----- [ ActionLinkGroupTemplate Select al
----- [{f] ActionLinkTemplate W
< 3 Select none

The table schemas appear in the Source Analyzer, and the data source is added to the
Sources subfolder of the repository folder. You can now create mappings and work with ASE

data in Informatica PowerCenter.
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43.2

Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - ] *
] Y
5’:’) Repository Edit  View Tools Layout Versioning Sources Window Help - & x
[ ODBC connections - [PCRS-LIN] ~ | @ .)“15 100% ~ £ @ '5; 'QD ':»éa
QDO | L5
==
. 2y B B g
E Repositories
T8 ecs CEEmewEGT T -
£ [ ODBC connections K Name Datatype ™
i [ Business Components 9 Id nvarchar
- @ Sources IsDeleted bit
5 [PRE-CONFIGURED DSN st OB -
) Targets Name K Name Datatype ™
Cubes
g Dimensions e [ nuarchar
. - Parentld nvarchar
-~ [ Transformations R T B an
we | SSSEODE) -
D e CreatedByld | K Name Datatype
applng.s i CreatedDate d h
i [f) User-Defined Functions = # eErchar
IsDeleted bit
Accountld [ RIRRSRNERO DB L=
CreatedByld K Name Datatype  *
CreatedDate % nvarchar
S AccountFromld nvarchar
Account Told nvarchar
COpportunityld nvarchar
Role nvarchar
< >
v
< >
=
=
| | | |\Save AFatch Log ,\Generate ,\Validate P\Debugger ,\Sesswon Log )\Noi'rficaticns f H £ >
Ready MUM

Connect to Informatica PowerCenter on Linux

You can set up and verify a connection between Informatica PowerCenter and ASE through

an ODBC driver on Linux.

Prerequisites

e Configure the Informatica services.
¢ Install Devart ODBC Driver for SAP Sybase Adaptive Server Enterprise. For instructions,

see Installation.

e Configure a data source name (DSN). For instructions, see Linux DSN Configuration.

Connect to ASE

1. Navigate to the directory where the ssgodbc.1inuxe4 utility is located.
cd /opt/informatica/tools/debugtools/ssgodbc/1inux64
2. Run the ssgodbc.1inuxe4 utility to verify the connection to ASE.

./ssgodbc.Tinux64 -d <your_dsn> -v
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3. Run a SQL query to retrieve data.

SELECT Id,Name FROM <table>;

~1% ed Jopt/informatica/tools/debugtools/ssgodbe/1linux64
linux641% ./ssgodbec.linux6 -v
] version information available (required by ./ssgodbc.linux64)

Driver ODBC wversion

Enter SQL string: SELECT Id,Name FROM Account;
Id

Name
00 1KBBROBBBRHMWY A4

Acme (Sample)
00 1KBOBOBOSRHMXYAS

Global Media (Sample)

44 Using in Microsoft Access

Connecting Microsoft Access to ASE Using an ODBC
Driver

This article explains how to connect Microsoft Access to ASE through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your ASE data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. It is
assumed that you have already installed and configured a DSN for ODBC driver for ASE. For
the purpose of this article, we tested an ODBC connection to ASE through our ODBC drivers
in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft Access
2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe how to

use Microsoft Access 2019 to import or link to your data in ASE.

Importing ASE Data Into Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/ase/

Using in Third-Party Tools| 129

0 N O O

9.

. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.

. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for ASE and click OK.
. In the Import Objects dialog box, select the tables that you want to import, and click OK.

. If the database objects have been successfully imported, you should the see the

corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.

The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to ASE Data in Microsoft Access Through an ODBC Connection

1

. Open your Microsoft Access database.

2.
3.

Select the External Data tab in the ribbon.

Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

. In the Get External Data - ODBC Database dialog box, select Link to the data source

by creating a linked table.

. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for ASE and click OK.

. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.

. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields

that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the ASE table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the

selected tables.
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9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

4.5 Using in Microsoft Excel

Connecting to ASE from Microsoft Excel using ODBC
Driver for ASE

You can use Microsoft Excel to access data from a ASE database using ODBC connector.
With ODBC Driver, you can import the data directly into an Excel Spreadsheet and present it
as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if you have
installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to ASE with Get & Transform (Power Query)

e Connecting Excel to ASE with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to ASE with the Query Wizard

e Connecting Excel to ASE with Microsoft Query

e Connecting Excel to ASE with PowerPivot

Connecting Excel to ASE with Get & Transform (Power

Query)

You can use Get & Transform (Power Query) to connect to ASE from Excel with ODBC. This

method assumes that you've installed an ODBC driver for ASE.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.
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Bookl - Excel Evgeniy Lemeshov [ O
Insert Page Layout Formulas Review View Help & Tellme X Share
& [o |_ B  a [TA ~N [ Be B 5
]
B, g2 o Y:&. " B B =
B i - .
Get Refresh z| Sort Filter Text to G What-If Forecast Outline
Data ~ D All = Y cColumns =8 7 Ex Analysis =~  Sheet M
G Sort & Filter Data Tools Forecast ~
j From File L
c v
[y
From Database L - - - - t ' ' =
— 4 »
R Y 0 - | + 100%
= am From Azure » From Table/Range
-]
_';jj From Online Services * _@ From Web
m —
.¢. From Other Sources * | & From Microsoft Query
[= 4
' - 3
S Combine Queries _.¢. From QDBEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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From ODBC

Data source name (DSN)

Devart ODBC Dniver b

4 Advanced options

Connection string (non-credential properties) (optional) &

501 statement [optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (opticnal)

(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.

ODBC driver
Default or Custom @ dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,

Windows

User name
Database myusemame

Password

FEERRBERDEE

Credential connection string properties (optional) (O

Back Cancel
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If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom '¢' dS'_' =Devart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (D)

Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

o X
Navigator
P Employees &
Select multiple items first_name last_name email gender
Display Options ~ D.a 1 Marja Chaloner mchaloner0@|atimes.com Femna
. 2|Emmalee Habben ehabbenl@twitter.com Fema
B detail
~ 3 Melantha Laimable milaimablel@ted.com Fema
B emp :
4| Lacie Alebrooke lalebrooke3@un.org Fema
= emp2 5 Hersh Mcettrick hmecettrickd@ photobucket.com Male
B Employees & Adlai Bradforth abradforth5@cisco.com Male
B loader 7| Dallis Brockman dbrockmant&@cdc gov Male
BT master 8 Shantee Killelay skillelay7@diigo.com Fema W
. L¥) 3|Hebert Micklem hmicklem8@alibaba.com Male
E mis £ >
Select Related Tables Load = Transfarm Data Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.
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H ©- Bookd - BEucel Evgeniy Lemeshov

File Hom | Inser | Page | Form | Data | Revie | View | Help | Table Design | Query O Tell me

F10 - Fe Indonesia v
A B C D E F G |«

1 idnﬁrst_namenlast_namenemil ngenderncountry

2 | 1 Marja Chaloner mchaloner0@latimes.com Female  Philippines

3 | 2 Emmalee Habben ehabbenl@twitter.com Female France

4 3 Melantha Laimable mlaimable2@ted.com Female Peru

5 | 4 Lacie Alebrooke  lalebrooke3@un.org Female China

6 | 5 Hersh Mcettrick hmecettrickd@photobucket.com Male China

7| 6 Adlai Bradforth abradforth5@cisco.com Male Peru

8 | 7 Dallis Brockman dbrockmanb@cdc.gov Male Indonesia

] 8 Shantee Killelay skillelay7@diigo.com Female Japan

10 9 Hebert Micklem hmicklema@alibaba.com Male |Indone5ia -

Sheet2 | Sheetl () 1 3
Ready HA 0 - | + 100%

Connecting Excel to ASE with Data Connection Wizard
(Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data
Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter
and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the
place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to ASE with the Query Wizard

You can use this option to create a simple query for retrieving data from ASE to Excel via
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ODBC driver.

1.
2.

0 N O O

Open Excel, in the main menu, click the Data tab.

Click the From Other Sources dropdown menu, and then click From Microsoft Query.

. In the appeared dialog, you can choose the data source you want to connect to.

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.
. Select Return Data To Microsoft Excel and click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is successfully imported to Excel.

Connecting Excel to ASE with Microsoft Query

You can use this option to create a more complex query for retrieving ASE data to Excel via
ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC ASE). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to ASE with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1.

In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.
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4.6

. In the opened window, click From Other Sources.
. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

. In the Specify a Connection String window, click the Build button.

a A~ W N

. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC ASE), and then click Next.
6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).
7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

Using in Microsoft Visual Studio

Importing ASE Data into Visual Studio Through an
ODBC Connection

A Visual Studio is a powerful tool containing features that allow editing, debugging, and
compilating the code and creating applications that can be connected to any databases
product and services on a local machine and network, and any type of cloud (private, public,
or hybrid). To connect Visual Studio to a data source such as ASE, you can use an
appropriate ODBC driver.

This guide describes how to connect to ASE and retrieve data importing them to Visual Studio
with an ODBC driver. It is assumed that you have already installed and configured a DSN for
ODBC driver for ASE.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.

2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data
source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down
list and select the previously configured DSN for ASE. Alternatively, you can connect to the
database by entering the DSN in a Use connection string field. To check whether your
connection is successful, click Test connection. Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.
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4.7

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the
table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

Using in Omnis Studio

When using ODBC Driver for SAP Sybase Adaptive Server Enterprise in Omnis Studio as a
data source, Omnis Studio does not display tables and other objects from dbo schema (it
considers them as system ones). To solve the issue, do the following:

1. After creating a session using Session Manager, in the SQL Browser tab, click Options.

© Ormrisstudio oo e
| Save Revert &) Dest Print | \D Browser CStore @ Motation :_. Props ﬁ Catalog ° Welcome
‘ |§, Trace Log {E}" Add-Ons
(D studio Browser - 0O X
o Back g9 |2 Folders Ev Views Search A
‘° Ormnis Studio 8.1.5 “ Session Manager - e
>{§} HUE Open Session @j
wﬁ Libraries
: i ASE
4 d SQL Browser Interactive Sgl
aly Ase Query Builder

lif: Tables OEtiCr‘IS
[ Views
5.:_‘_ Stored Procet

> @y Vs

>EE§ Web Service Server

1 object(s), 0 selected ]

2. In the opened dialog, check Include System objects and click Save.
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© O Studio e s
| Save Revert &) Dest Print | \ﬂ' Browser CStore @ Motation Props ﬁ Catalog e Welcome
‘ E, Trace Log ‘?}' Add-Ons
@ studio Browser - 0O X
0 Back @/ v Views Search A
‘e Ormnis Studio 8.1.5 Session Manager - e
“{i'l HUB Open Session %}
@ Applets
% Samples Interactive Sgl ASE
&; Faults Query Builder
Opti Options
B_ p_ ons [0 SQL Object Brawser Options X
"E Libraries
B ﬁ SQL Browser Objects |Drag 8 Drop | Query History | Stored Queries
># ves When displaying ohjects:
>@i Web Service Server
() Only show objects owned by current user
@ Show objects owned by any user
[ Save ] [ Cancel
1 object(s), 0 selected ]
|
In this case, all the required tables and objects will be displayed by Omnis Studio.
4.8 Using in OpenOffice and LibreOffice

Connecting to ASE from OpenOffice and LibreOffice
using ODBC Driver for ASE

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access ASE data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.
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To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for ASE,
perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache s ™
e OpenOffice™4

@ Spreadsheet @ Database
Presentation E Formula
@ Open... bt |_r/_| Templates...

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for ASE, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

142 ODBC Driver for ASE

Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for ASE and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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MNew Database.odb - OpenOffice Base -

File Edit View Insert Tools Window Help

‘R-E2-u =R B°E |

ﬁ

£ Use Wizard to Create Table...
E Create View...

|

(2]
&
m
7]

Ei Create Table in Design View.. ‘ Description

i

e

= | :
1E =] dbo

Forms blob_types

coil_status

coil_status1

Reports coil_status2
=] dactest.dbo.Employees - Mew Databasel& - OpenQOffice Base: Table Data View - O X
File Edit Wiew Insert Tools Window Help
LIl JEMEE YR AR
id | first_name | last_name | email gender country
B (1 Marja Chaloner ‘mchalonero@latimes.com  Female Philippines
: 2 Emmalee Habben ehabben@twitter.com Female France
I3 Melantha Laimable mlaimable2@ted.com Female Peru
4 Lacie Alebrooke lalebrooke3@un.org Female China

: 5 Hersh Mcettrick hmeettrickd@photobucket.cor Male China
16 Adlai Bradforth abradforth3@cisco.com Male Peru
7 Dallis Brockman dbrockmane@cdc.gav Male Indonesia
I8 Shantee Killelay skillelay7@diigo.com Female Japan
19 Hebert Micklem hmicklem&@alibaba.com Male Indonesia
| Rick Bakster rbaksterg@last.fm Male Ireland
I Calli Preddy cpreddya@businessweek.com Female Russia
|12 Kelci Gilbanks kgilbanksb@apache.org Female China
AL Jasmina Trevallion Jtrevallionc@yahoo.com Female Vietnam
|4 Cilka Canti ccantid@loc.gov Female Russia

7. To create an SQL query, click Queries in the Database pane, then click Create Queryin

SQL View...
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4.9

MNew Database.odb - OpenOffice Base

File Edit Wiew

B - -

Insert Tools

Window Help

- @

ﬁ

[ Create Query in Design View...
lﬂ Use Wizard to Create Query...

Tables

|§Eu. Create Query in SQL View... |

Description
Create a query entering an SOL statement dire

e

Queries

ﬁ

Farms

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Database.odb : Queryl - OpenOffice Base: Query Design

File Edit View Insert Tools

Window Help

=11 & D gy
: St NRIKT vI¥

id | first_name last_name email gender | country
Al Marja Chaloner mchaloner0@latimes.com |Female Philippines |
]2 Emmalee Habben ehabben1@twitter.com Female France
3 helantha Laimable mlaimable2@ted.com Female Peru
|4 Lacie Alebrooke lalebrooke3@un.org Female China
s Hersh Mcettrick hmeettrickd @photobucket.c Male China
|8 Adlai Bradforth abradforthS@cisco.com Male Peru
|7 Dallis Brockman dbrockmané@cdc.gov Male Indonesia
|8 Shantee Killelay skillelay7@diigo.com Female Japan
e Hebert Micklem hmicklemg@alibaba.com  |Male Indonesia
1o Rick Bakster rbaksterd@last.fm Male Ireland
_n Calli Preddy cpreddya@businessweek.co Female Russia
L Kelci Gilbanks kgilbanksb@apache.org Female China
Record 1 [ of 40+ 1]

SELECT * FRCM Employees;

Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
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stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for ASE, create an initialization file for your

Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initASE.ora. You need a separate initialization file for each ODBC data source. After creating
the file, set the Hs_FDs_coNNECT_INFo parameter to the system DSN that you created earlier,
for example:

HS_FDS_CONNECT_INFO=ASE

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_Name) must be the same in 1istener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
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SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=
(SID_NAME=ASE)
(ORACLE_HOME=D : \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The s1p must match the value specified in the

listener.ora file.

ASE =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
(SID = ASE)

(HS = 0K)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"db1link_name"

See also
Configuring Oracle Database Gateway for ODBC
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410 Usingin PHP

Connecting to ASE from PHP using ODBC Driver for
ASE

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing ASE via ODBC. The script connects to ASE

database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$obpBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for ASE};Serv
Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set
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4.11

41141

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

$result = odbc_result_all($Recordset, "border=1");
. odbc_cTlose($0DBCConnection);
?>

You can modify this script by specifying general settings for each Devart ODBC driver to use
any of them with your PHP projects.

Using in Power Bl

This section describes how to establish and troubleshoot a connection to ASE from Power Bl
using ODBC Driver for ASE.

e Using in Power Bl

e Troubleshooting in Power Bl

Using in Power Bl

Importing ASE Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as ASE, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to ASE and import data into Power Bl Desktop using an
ODBC driver. It is assumed that you have already installed and configured a DSN for ODBC
driver for ASE.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for ASE
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4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the ASE data into Power Bl for analysis, select the needed table and click Load.

411.2 Troubleshooting in Power Bl

When using ODBC Driver for SAP Sybase Adaptive Server Enterprise in Power BI, to avoid
any issues related to reserved words usage, do the following:

1. Check the Quoted Identifier option.
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412

Devart ODBC Driver for Adaptive Server Enterprise Configuration X

General Advanced setiings  Secure settings License  About

Meta Data

Empty strings as MULL Allows MULL strings

Connection Settings

Connection Timeaout

IP Version IPv4 e
Quoted Identifier

Data Type Settings

String Types Default e
[ allow fixed types

Use Local Regional Settings when converting to string

[ ] Mumbers [ ]Dates and times

Test Connection vor Cancel

In this case, any character string enclosed in double quotes in queries or stored procedures
will be considered by Adaptive Server as an identifier and parsed without errors.

Using in Python

Installing the ODBC Driver for SAP Sybase Adaptive
Server Enterprise
One of the most convenient methods to connect to an external database or access cloud

data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for ASE. To use the ODBC driver as a
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translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to ASE from Python using ODBC Driver for
ASE

Here’s an example to show you how to connect to ASE via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect
import pyodbc _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for ASE};Server=myserver;P

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnhxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:

print (row)

row = cursor.fetchone()
cursor.close()
cnxn.close()

4.13 Using in QlikView

Connecting to ASE from QlikView using ODBC Driver for
ASE

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/ase/

156 ODBC Driver for ASE

This tutorial describes how to connect and configure QlikView to retrieve data from ASE for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for ASE, perform the
steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).

@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Refresh Document
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+S
Save As... F12
= Save Link...

Mail as Attachment...

Mail with Bookmark as a Link

all Print... Ctrl+P

Print as PDF... Ctrl+Shift+P
Print Sheet...

AN Print Preview...
Source Control 4
Export »

| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select

the Data Source you created earlier, type in the User ID and Password if your database is
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password-protected. You can test the connection by choosing Test Connection. The

Connection Test succeeded message should appear. Click OK to connect to your data

source.

V]

i File Edit Insert Tab Tools Help

=

) Reload #Debug | [l & | & -2 ] 2O [0 <1 2l Tabs Main > |5 =

[EET]

@ Connect to Data Source =

User D Pagsword

|myid | | sesesl |

Cancel

Data Sources Help

Dewart ODBC Driver for ASE
Devart ODBC Diriver for Firebird i
Dewart ODBC Driver for Interbase
- - - Devart ODBC Driver for bagento
Dats  Functions Variables  Settings Devart ODBC Driver For MailChimp
. Dievart ODBC Diriver for MySQL
Database Data from Files | | Dewart ODBLC Diriver for MetSuite

: Devart ODEC Crriver for Oracle
| oDeC > Connect... L] Relative Paths Dewart ODBC Driver for SHL Azure

. CuseFTP Devart DDEC Driver for $0Lite
[ Farce 32 Bit Select... Neseart OCRE Nriver for vRace

[15how User DSMs

Test Connection...

0K Cancel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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@ Edit Script [C\Users\EvgeniyL\Documents\new.qvw*] = O >
! fFile Edit Insert Tab Tools Help
E} Reload B pebug | [l & | £ =2 B 2 (3 &1 2 Tabs Main v |8

bdain

ODBC CONNECT TO [Devart ODBC Driwer for ASE];
SELECT * FROM dactest.dbo.Employees

Data  Functions Variables  Settings

Databaze ['ata from Files
| ODEC - Clammiss. [ Relative Paths Table Files...
[JUseFTP o
[ Foree 32 Bit Select... sz (L=
“Web Files...
Field Data...
Cancel Help
Sheet Properties [Main] >
General Fields  Objects  Securty Triggers
Awvailable Fields Fields Displayed in Listboxes
Cona | courtry
gender Add > first_name
id
last_name Add Al ==

< Remove

4. Alternatively, you can click Select, and QlikView will show you the database structure
window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 159

and fields. You can retrieve date from multiple tables and fields by selecting them and
clicking Add. When you are ready with your SELECT statement, click OK. You will get
back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

@ Create Select Statement = O x
Dele caED |Devar1 ODBC Driver for ASE | Baiesh.,
Databasze | dachest v| Driver...
Owuner | dho V| Suppart...

Database T ables Figlds | Text Order ~ |
Olshonal  [enp2 ~| [ ~
Tahles Employees Countny
[Jviews loader email

maszter first_name
L] Synenyms i gender -
[I5pstem Tables | mig a
[ &liazes numeric tines ¥ | [ Show lcon for Key Fields

Soript Table  Columns  Preview  Blobs

SQL SELECT * (®) Column
FROM dactest.dbo.Employees; O Row
() Structured
[ Preceding Load
Add

Carcel | Hop

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.
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414

) QlikView x64 Personal Edition - [CUsersh ODBC\ Documentsh 1.gvw™]

File Edit View Selections | Layout | Settings Bookmarks Reports  Tools  Object Window  Help
RN (= | | & ETNLs I Add Sheet.., L7 g Kl Clear ~ | (& Back (2 Forward | (5 |
_ W Promote Sheet
Main
B ¥l Demote Sheet
id P
1 408 Remove Sheet
2 ; .
= y=] 43| Select Fields...
4 A1 New Sheet Object v || [B] List Box...
5 E
6 %1 Rearrange Sheet Objects Zi|| Statistics Box...
; #Y Adjust Off-Screen Objects Ell Multi Box...
9 Align/Distribute v [ Table Box..
10 al| Chart...
11 o
12 it =|| InputBox...
13 v, .
14 V| Current Selections Box...
15 2| Button...
16 3
@ alikview x64 Personal Edition - [CA\Users\EvgeniyL\Do cumentsynew.gqvw®] = O X
! file Edit WView Selections Layout Settings Bookmarks Reports Tools Object  Window Help -8 X
PNES H S EE| 9 O F k] 2] ‘_")P\?? K Clear | @ Back @) Forward | & Lock ;T'Unlock
Main
Bl g
country email first_name gender id last_name
Albania mfiennes10@nationalgeographic.com  Munroe Male 37 Fiennes
Argentina elagadu Ivizyoutube.com Ebeneser Male 68 Lagadu
Argentina mionescol7@bbb.org Maxim Male 44 Tonesco
Armenia mhachard2o@skype.com Marvin Male 85 Hachard
EBolivia maudrey25@soup.io Mora Female 78 Audrey
Brazil asambellsZl@paypal.com Astrid Female 24 Sambells
Brazil ctuson22@va.gov Cyrill Male 75 Tuson
Brazil Imacknocker2o@linkedin.com Lelia Female 97 MacKnacker
Brazil Iweymontik@sitemeter.com Lyndy Female 57 Weymont
Brazil mipyrahj@tacbac.com Margot Female 200 Pyrah
Canada bpackingtonls@statcounter.com Baily Male 65 Packington
Canada meashin1rZjisthis.com Mollze Female &4 Cashin
China acoyeZm com Agustin Male 95 Coye
China ascrim timesonline.co.uk Amne Male 71 Serimshire
China bsaffin ageshack.us Barrie Female 96 Saffin
China chow zdnet.com Carline Female 34 Bowmer
China cSymer e-recht24.de Carilyn Female 47 Symers

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to ASE from SQL

Server Management Studio using ODBC Driver for ASE.

¢ Creating a Linked Server

e Troubleshooting in SSMS
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4141 Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN.

¢ The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysWOW64\odbcad32.exe.

e ODBC Driver for SAP Sybase Adaptive Server Enterprise and SQL Server must be
installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to ASE from SQL Server Management
Studio using ODBC Driver for ASE

You can use the Microsoft SQL Server Management Studio to connect your ASE data to an
SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as ASE and
merge them with your SQL Server database. You can create a linked server with one of these
methods: by using the options in the Object Explorer or by executing stored procedures.

Below are major advantages of using SQL Server Linked Servers to connect to ASE:

1. The ability to connect other database instances on the same or remote server.
2. The ability to run distributed queries on heterogeneous data sources across the
organization.

3. The ability to work with diverse data sources in the same way.
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How to configure a SQL Server Linked Server to connect
to ASE

You can follow the steps to create a linked server for ASE in SQL Server Management Studio
by using Object Explorer:
1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers
and then click on New Linked Server.
3. Configure your linked server in the dialog box:
e Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for ASE.

Alternatively, you can input the ODBC Driver connection string in the Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access ASE databases through SQL Server.

Retrieving Data From ASE

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer * I x
Connect~ ¥ *¥ (VI
= @ EVGEMIYL\SQLEXPRESS (SOL Server 14.0.1000 - C
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL
wh search.CollatorDs0O

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers — O
e e IT Script « ﬂ Help
& General

Provider options:

Enable MName ~
[Cynamic parameter

MNested queries

U
U
[]

Level zero only
Allow inprocess
Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator ¥

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
Selecta page HSGI‘iDt"ﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. ASE. In the Product Name and Data
Source fields you need to indicate the System DSN that you've previously created - more info
on System DSN setup can be found here.
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X Mew Linked Server = O *
Selecta page T Scipt ~ @ Help
& General
& Securty
& Server Options Linked sarver ASE
Server type:
(C) SGL Server
(@) Other data source
Provider: Microsoft OLE DB Provider for ODBC Drivers ~
Product name: | Devart ODBC Diiverfor ASE |
Data sounce: |Ft5E |
Provider string: | |
Location | |
Catalog | |
Connechion

The ASE tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:

File Edit View Project SQOL Complete Tools Windoy

i@-o |- n-2 ¥ | B New query B R &
:ff | | b Execute
I
Object Explorer * 0 x
Connect~ ¥ ¥ VS

= @ EVGEMNIVL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
2
Providers
H oracLE
B PosSTGRESQOL
B saurte

Enter your SQL query in the editor window and click Execute to run the query:
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4« SQlQuerys.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St., | Quick Launch (Ctri+Q)

414.2

File Edit View Query Project SQOL Complete Tools Window Help
(oo B o R Brewauey BR SRR XTD|[2-C -85 RE=l
© % | master P Exeate » v EEE[E] | BED| =0,
— —
Object Explorer SQLQueryé.sql - E..S.master (sa (54))* + X _
Connect~ ¥ *¥ ¢ —|SELECT * FROM [ASE].[dactest].[dbo].[Employees]; S
FS
B dbo.coil_statusé ~ T
B dbo.coil_status7
H dbo.complex_field
R dbo.COMPLEX_FIELD M
EH dbo.crgrid_test 0% ~j '
m dbo.dept EH Results Eﬁ Messages
B dbo.detail first_name  last_name  email gender  country ~
m dbo.emp 1 Marja Chaloner mchalonerl@latimes.com Female  Philippines
B dbo.emp2 2 2 Emmalee  Habben ehabben1@twitter.com Female France
B dbo.Employees 3 3 Melantha Laimable  mlaimable2@ted.com Female Pem
B dbo.loader 4 4 Lacie Alebr\:u.oke Ialebmo-keE@un.org Female Ch?na
B dbo.master 5 5 Hers.h Meettrick hmceﬂnckxi@p.hotobucket.com Male China
- 6 6  Adlai Bradforth  abradforth5@cisco.com Male Peru
= dbo'mf:‘ 7 7 Dalis Brockman  dbrockman&@cde.gov Male Indonesia
B8 dbo.mis 8 8  Shantee Killelay skillelay 7@diigo.com Female Japan
B dbo.numeric types 9 9  Hebert Micklem hmicklem8@alibaba.com Male Indonesia
B dbo.5alesOrders2 10 1. Rick Bakster  rhaksterd@lastfm Male  Ireland
B dbo.simple_types 11 1. Call Preddy cpreddya@businessweek.com  Female  Russia
B dbo.simple_types_tmp 12 1. Kelai Gilbanks  kgilbanksb@apache org Female China o
B dbosimple_types2 v a0 1 e T e e o e T
< > @ Query execu... | EVGENIYL\SQLEXPRESS (14.0 RTM) | sa (54) | master | 00:00:06 | 100 rows

As a result, you can see the contents of the selected table retrieved directly from the ASE
account you are connected to.

See also
¢ Troubleshooting SSMS

Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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-
. Compenent Services

Console Root
a 0 Component Services
4[] Computers
a & My Computer
» [o] COM+ Applicatio
[ -] DCOM Config
& [2] Running Processe
[ fj] Distributed Trans:
[ E Event Viewer (Local)
3 Q.,, Services (Local)

Windo.., Windows... Windows R.. Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo.,..  Windows.. WMIPro.. WMIProvi.

s & & &

Micresoft.... Microsoft.L... MicrosoftV... Microsoft....

ApplD
MMC (ALY MSMDPP - MsRdpSess...
Applicati.. LIZE

¥ & & &

MSTTS MahimicSe... MAP Agent Map Elevated
DecObj Cla.. Service COM class
NCLUA NDFAPI netman netprofm

¥ & & @&

NetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions »

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:

© 2025 Devart  Request Support ODBC Forum Provide Feedback



https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

168 ODBC Driver for ASE

F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

.
| Permissions for (2206CDB0-10C1-11D1-89E0-00COAF... ()

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

oK ]| Cancel Apply

After this you should be able to edit MSDAINITIALIZE security settings.

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

415 Usingin SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for ASE as a

translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://support.microsoft.com/en-us/kb/2647989
https://support.microsoft.com/en-us/kb/2647989

Using in Third-Party Tools| 171

an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data
Connection
-—
Compatibility
ODBC Behavior | Ver 2.x ||
String Types Default &

IUse Local Regional Settings when converting to string

[ Imumbers [ ]Dates and times

Test Connection - Cancel

416 Usingin Tableau

This section describes how to establish and troubleshoot a connection to ASE from Tableau
using ODBC Driver for ASE.

e Using in Tableau

e Troubleshooting in Tableau on macOS
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4.16.2

Using in Tableau

Importing ASE Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to ASE from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for ASE. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for ASE from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in ASE.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.

Troubleshooting in Tableau on macOS

Troubleshooting ODBC Connection in Tableau on
macOS

The iODBC driver manager incorrectly handles the SQL_WCHAR and SQL_WVARCHAR
ODBC data types. To work with these data types in Tableau, create a Tableau Datasource
Customization (. tdc) file in 'Users\[your name]\Documents\My Tableau Repository
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\Datasources\' — for example, devart-ase.tdc, and add the following capabilities to the file:

<?xml version='1.0"' encoding='utf-8' 7>
<connection-customization class='genericodbc' enabled='true' version='1.0"'>
<vendor name='ASE' />
<driver name='Devart ODBC Driver for ASE' />
<customizations>
<customization name='CAP_ODBC_BIND_SUPPRESS_WIDE_CHAR' value='yes'
</customizations>
</connection-customization>
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